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Notice

1.

10.

1.
12.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products
covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or 1/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LS|, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between ViL (Max.)
and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi1 (Min.).

Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



How to Use This Manual

This manual describes the role of the e? studio integrated development environment for developing applications
and systems and provides an outline of its features .

e? studio is an Integrated Development Environment (IDE) for RX family, RL78 family and RZ family, integrating
the necessary tools for the development phase of software (design, implementation, and debugging) into a
single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without
the need to use many separate tools .

Readers This manual is intended for users who wish to understand the functions of the
e? studio and who design software and hardware applications.

Purpose This manual aims to provide the user with the explanation of the features provided by
e? studio when they commence the development of their hardware and software
systems using the targeted devices.

Organization This manual can be broadly divided into the following sections.

CHAPTER1 GENERAL

CHAPTER 2 INSTALLATION

CHAPTER 3 IMPORT / GENERATE PROJECT
CHAPTER 4 BUILD

CHAPTER 5 DEBUG

CHAPTER 6 HELP

How to Read This Manual It is assumed that the readers of this manual have general knowledge of electronics,
logic circuits, and microprocessors.

Conventions Data significance: Higher digits on the left and lower digits on the right

Active low representation: XXX (overscore over pin or signal name)

Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention
Remark: Supplementary information

Numeric representation:  Decimal ... XXXX



List of Abbreviations and Acronyms

Abbreviation Full Form
API Application Programming Interface
ARM Advanced RISC Machine

CAN Controller Area Network

CDT C/C++ Development Tooling

CG peripheral Code Generator

CPU Central Processing Unit

ELF/DWARF Executable and Linkable Format / Debugging With Attributed Record Formats
FIT Firmware Integration Technology

GB Gigabyte

GCC GNU Compiler Collection

GDB GNU project DeBugger

GHz Giga Hertz

GUI Graphical User Interface

IDE Integrated Development Environment
I/O Input / Output

JTAG Joint Test Action Group

LCD Liquid Crystal Display

LED Light Emitting Diode

LVDS Low-Voltage Differential Signalling

MCU Microcontroller Unit

0S Operating System

PC Personal Computer or Program Counter
PMOD Peripheral MODule (an open standard defined by Digilent Inc™)
RTOS Real Time Operating System

SC Smart Configurator

SD Secure Digital

SFR Special Function Registers

SVN SubVersioN

TFT Thin Film Transistor

URL Uniform Resource Locator

USB Universal Serial Bus
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e? studio Getting Started Guide User's Manual

1. General

Renesas e? studio is the Integrated Development Environment for Renesas embedded microcontrollers. e?
studio is based on the industry-standard open-source Eclipse IDE framework and the C/C++ Development
Tooling (CDT) project, covering build (editor, compiler, and linker control) and debug phases with an extended
GNU Debug (GDB) interface support.

This chapter describes the system configuration and operating environment for the e? studio IDE for developing
applications for the RZ family high-end ARM-based microprocessors.

1.1 System Configuration

Below is an example of a typical system configuration.

Reset Video USB Func.

Switch IN (Reverse) Pmod™
TFT Application Audio
board (optional) INOUT

Renesas

Pmod™
Lco

e? studio

8D Card
(Reverse)

JTAG
Header
CAN

USB Serial

J-Link LITE ARM

)
TFT Touch

TFT Header  Analog Adjust  User LEDs

Figure 1-1. System Configuration Example - RZ/A1H Renesas Starter Kit

1.2 System Requirements
Below are the system requirements for this product.
Hardware Environment:

. Processor: At least 1GHz (hyper-threading/multi-core supporting CPU)

*  Main Memory: At least 4GB of free space. 8GB is recommended.

. Hard disk Capacity: At least 2GB of free space

+ Display: Resolution at least 1,024 x 768; at least 65,536 colors

. Interface: USB 2.0 (High-speed/Full-speed). High-speed is recommended.

Software Environment:

Windows® 8.1 (32/ 64-bit versions) and Windows® 10 (32/64-bit versions)
64-bit OS is required for e? studio 2020-04 or later.

R20UT4535EJ0102 Rev 1.02 aEN ESNS Page 1 of 79
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e? studio Getting Started Guide User's Manual

1.3 Supported Compiler

RZ family devices use GNU compilers for ARM architecture. Each device has a recommended version of the
GNU compiler. Refer to https://www.renesas.com/rz. These compilers can be installed during the installation of
e? studio by selecting them in the Additional Software pane (an Internet connection is required - see chapter
2.1) or can be downloaded from the web page below and installed separately (toolchain integration will be
necessary).

+  GNU ARM Embedded toolchain (GCC 6; 6-2016-g4-maijor or higher version):
https://developer.arm.com/open-source/gnu-toolchain/gnu-rm/downloads

+  GNU ARM Embedded toolchain (GCC™e 5; 5-2016-g3-update or lower version):
https://launchpad.net/gcc-arm-embedded/+download

. GNUARM-NONE toolchain:
https://gcc-renesas.com/rz/rz-download-toolchains/

Refer to chapter 2.2 for compiler installation and chapter 2.6 for e? studio toolchain integration.

Note: ‘GCC’ stands for ‘the GNU Compiler Collection’ (Refer to https://gcc.gnu.org/).

1.4 Additional Tool for Compiler Update

Libgen Update for GNU ARM Embedded Toolchains is a tool used to build ‘newlib’ specific libraries which is
a C standard library implementation intended for embedded systems. Instead of a ‘prebuilt’ version of a library
(a library built with a set configuration when the toolchain is created), the Libgen Update allows users to have
their own ‘project-built’ library build configuration, using a custom set of options.

Libgen Update for GNU ARM Embedded Toolchains can be installed during the installation of e? studio if
selected (an Internet connection is required), or can be downloaded from the web page below:

*  Libgen for GNU ARM embedded toolchain (V1.2018.02 or higher version)
https://gcc-renesas.com/rz/rz-download-toolchains/

Refer to chapter 2.2 for the installation of Libgen Update for GNU ARM Embedded Toolchains.
1.5 Supported Emulator
Segger J-Link Lite (RZ) and other emulators

For more detail, see RZ family product web page: https://www.renesas.com/rz

R20UT4535EJ0102 Rev 1.02 RENESAS Page 2 of 79
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2. Installation

The latest e? studio IDE installer package can be downloaded from Renesas website for free. Renesas now
supports both 32-bit and 64-bit versions of e? studio.

Please check detailed information from: https://www.renesas.com/e2studio . Note that user has to login to the
Renesas account (in MyRenesas page) for the software download.

This chapter describes the installation and un-installation for the e? studio IDE.

e? studio installer can be used to upgrade e? studio as well as new installation. However, it does not support
update between major versions such as from v5.x to v6.y, or from v6.m to v7.n.

Please uninstall the earlier versions before installation. Alternatively, install new e? studio into a new folder if
you would like to keep earlier versions.

The detailed information is described below.

2.1 Installation of e? studio IDE (64-bit version)

1. Double-click on e? studio installer to invoke the e studio installation wizard page. Click [Install].

Note: If 2 studio was installed in your PC, the option to modify, remove the existing version or install 2
studio to a different location will be displayed.

=N Renesas e studio 2020-04 Setup O X
Renesas e” studio 2020-04 Setup
RENESAS

e2 studio version 20.4.0.R20200328-1512 is already installed.

What do you want to do?

Modify
Add or remove features in the existing installation.
Location: C\Renesas\e2_studio

Remove
Uninstall the existing version.
Location: C\Renesas\e2_studio

Install
Install to a different location.

v202003281637 < Back Next > nsta Cancel

Figure 2-1. 64-bit e2 studio installation wizard

R20UT4535EJ0102 Rev 1.02 RENESAS Page 3 of 79
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2. Welcome page

User can change the install folder by clicking [Change...]. Click [Next] to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.

Note2: Multi-byte characters cannot be used for e? studio installation folder name.

E! Renesas e? studio 2020-04 Setup

@ Welcome l ° Install directory ready

Install Location: C:\Renesas\e2_studiq| [Change...]

° Prerequisite software already installed
Internet connection available
Change Proxy Settings...
Ready to install
Software to install:

» Renesas e2 studio v20.4.0.R20200323-1711

« Java Runtime v11.0.0

= Open)DK JRE v11.0.6.202001311027

~ openjfx.media.feature v11.0.2.201912141636

» openjfx.standard.feature v11.0.2.201912141636
- openjfx.swing.feature v11.0.2.201912141636

- openjfx.swt.feature v11.0.2.201912141636

- openjfx.web.feature v11.0.2.201912141636

Additional components can be selected on the next page
Size of install: 446.2 MB

Temporary space required: 732.6 MB
Available: 46.9 GB

v202003231833 < Back Install

Renesas e® studio 2020-04 Setup .1 E N ESAS

O X

Cancel

Figure 2-2 Installation of 64-bit e? studio — Welcome page

R20UT4535EJ0102 Rev 1.02 REN ESNS
24 Sep, 2020
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3. Device Families

Select Devices Families to install. Click the [Next] button to continue.

X Renesas e? studio 2020-04 Setup O X
Renesas e’ studio 2020-04 Setup - 2E NESAS
Select the device families you wish to install support for
Welcome [] AW RA
. . RA Build, Debuqg & Code Generation support for Renesas RA devices
@ Device Families
@F‘!Z AW RZ
Build, Debug & Code Generation support for Renesas RZ devices
O] RLC7E
A Build, Debug & Code Generation support for Renesas RL78 devices
O R RX
e Build, Debug & Code Generation support for Renesas RX devices
] A RH850
RHE50 Debug support for Renesas RH850 devices
| A% RE
Re Build & Debug support for Renesas RE devices
Select All
v202004121319 < Back Install Cancel
Figure 2-3. Installation of 64-bit e2 studio — Device Families
R20UT4535EJ0102 Rev 1.02 RENESAS Page 5 of 79
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4. Extra Features

Select Extra Features (i.e. Language packs, SVN & Git support, RTOS support...) to install.
For non-English language users, please select Language packs at this step.

Click the [Next] button to continue.

Renesas e’ studio 2020-04 Setup - QE N ESAS

Select the extra features you wish to install

Welcome P, Japanese Language Support

Device Families

@ Extra Features |

Py Chinese (Simplified) Language Support

Chinese (Traditional) Language Support

flil\u Git Integration

o Git SCM Support

flil\u Terminals

o ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet
RTOS

0 O O O O O
)

FreeRTOS & OpenRTOS Debuqg Support

Select All

v202004121319 < Back Install Cancel

Figure 2-4 Installation of 64-bit e2 studio — Extra Features

R20UT4535EJ0102 Rev 1.02 aENESAS Page 6 of 79
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5. Customise Features

Select the components to install and click the [Next] button to continue.

E! Renesas e? studio 2020-04 Setup

Renesas e” studio 2020-04 Setup

Select the components you want to install.
Renesas e2 studio (20.4.0.R20200412-1149)
=[] Java Runtime (11.0.0)
Extra Features Dpen)DK & OpenlFX

Welcome

Device Families

@ Customise
Features

% (/] Renesas e2 studio Tools (20.4.0.R20200412-1149)

< (J Renesas RA Family Support (20.4.0.R20200412-1149)

% ] Renesas RZ Family Support (20.4.0.R20200412-1149)

% [¥] Renesas e2 studioc Common Components (20.4.0.R20200412-1149)

% () Renesas e2 studic Common Components for ARM Devices (20.4.0.R20200412-1149)

(| X

RENESANS

W
Select All Optional | Deselect All Optional
Size of install: 711.4 MB
v202004121319 < Back Install Cancel
Figure 2-5 Installation of 64-bit e2 studio — Features
R20UT4535EJ0102 Rev 1.02 RENESAS Page 7 of 79
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6. Additional Software

Select additional software (i.e. compilers, utilities, QE...) and click [Next] to continue.

Note: With no Internet access available, additional software installation can be skipped because software
catalog cannot be downloaded. The additional software can be installed later.

A Renesas e? studio 2020-04 Setup ] X
2 -
Renesas e* studio 2020-04 Setup - QE NESANAS
Select the additional software you wish to install
Welcome |GCc Toolchains & Utilities (0) |
Device Families = GNU ARM Embedded A
Extra Features [ "] GNU ARM Embedded 6 2017q2 6.0.0.2071743
Customise GNU ARM Embedded 6 20172
TeineEs Download size: 82.6 MB
© Additional [ LibGen for GNU ARM Embedded 1.1.0
Software LibGen for GNU ARM Embedded (requires GNU ARM Embedded toolchain)
ze:7.6 MB
0 B download required
v202004121319 < Back Install Cancel
Figure 2-6 Installation of 64-bit e? studio — Additional Software
R20UT4535EJ0102 Rev 1.02 RENESAS Page 8 of 79
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7. License Agreement
Read and accept the software license agreement. Click the [Next] button.

Please note that user must accept the license agreement, otherwise installation cannot be continued.

=X Renesas e studio 2020-04 Setup O X
2 .

Renesas e* studio 2020-04 Setup - QE NESAS
Welcome Please read and accept the following Software Agreements
Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio ~

OpenJDK License Agreement
Extra Fe-atures ARM DS-5 Toolchain Integration This Renesas e2 studio |icen.se e?greem.ent {"Agreement'i) is between the entity on
Customise whose behalf you are entering into this Agreement ("Client") and Renesas
Features Electronics Corporation, a Japanese company with its registered office at 3-2-24,
Additional Toyosu, Koto-ku, Tokyo 135-0061, Japan (“Renesas”). YOU SHOULD READ THIS
Software AGREEMENT CAREFULLY, AS IT CONSTITUTES A BINDING CONTRACT BETWEEN
CLIENT AND RENESAS.
@ Licenses The Renesas IDE Software (defined below) is intended for commercial use by a

company or corporation only and is not designed, developed or produced for any
private use or purpose. If you are an individual, or you intend to install the Renesas
IDE Software on behalf of an individual, or the Renesas IDE Software is expected to

be used for a private purpose directly or indirectly, you should click "No" on the
installer.

Otherwise, by clicking the "I accept™ button or other button or mechanism

designed to acknowledge agreement to the terms of an electronic copy of this
Agreement, or by installing, accessing, or otherwise copying or using all or any

< 3 | portion of the Renesas IDE Software, you accept this Agreement on behalf of the  «

I [v]il accept the terms of the Software Agreements I Print all...

v202004121319 < Back Install Cancel

Figure 2-7 Installation of 64-bit e? studio — Licenses

R20UT4535EJ0102 Rev 1.02 RENESAS Page 9 of 79
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8. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

Note: If e? studio was installed in another location, it is recommended to rename to distinguish from the
other e? studio(s).

&4 Renesas e? studio 2020-04 Setup O et

Renesas e” studio 2020-04 Setup - 2E NESANAS

Welcome Shortcuts to important programs and files will be created in the following

. . locations:
Device Families

Extra Features
In start menu group: | Renesas Electronics e2 studio

Customise
) Restore Default
Features

Additional
Software

Licenses

@ Shortcuts |

v202004121319 < Back I Next > I Install Cancel

Figure 2-8 Installation of 64-bit e? studio — Shortcuts
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9. Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to install

the Renesas e? studio IDE.

& Renesas e studio 2020-04 Setup O X
Renesas e’ studio 2020-04 Setup - zE N ESAS
Welcome Ready to install "
Device Families Software to install:
Ext « Renesas e2 studio v20.4.0.R20200412-1149
ra Features
« Java Runtime v11.0.0
Customise + Renesas e2 studio Common Components v20.4.0.R20200412-1149
Features « Renesas e2 studio Common Components for ARM Devices v20.4.0.R20200412-1149
Additional + Renesas e2 studio Tools v20.4.0.R20200412-1149
Salfirane = Renesas RZ Family Support v20.4.0.R20200412-1149
. « Renesas RZ Family Support (requiring .Net Framework) v20.4.0.R20200412-1149
Licenses « ARM DS-5 Toolchain Integration v1.0.1.v20190913-0848
Shorteuts « Eclipse CDT Linker Script Editor and DSL v1.0.100.v20200227-2154
= GCC for Renesas RZ Build Support v20.4.0.+20200313-1349
= GCC for Renesas RZ Support Files v20.4.0.v20200312-1402
= OpenJDK JRE v11.0.6.202003262236
= Renesas Build Support Files v8.0.0v20191202-1049
+ Renesas Common Project Import/Export v8.0.0.v20200316-1416
= Renesas Debug Views v8.0.0.v20200316-1420
* Renesas RTOS Debug Views v8.0.0.v20200316-1436
« Renesas RZ Debug Support v20.4.0v20191201-1151
= Renesas RZ Debug Support Files v20.4.0.v20200322-0311
= Renesas Smart Configurator for RZ v20.4.0.v20200314-1045 v
v202004121319 Next > Cancel

Figure 2-9 Installation of 64-bit e? studio — Summary

10. Installing...

The installation is performed. Based on selected items of Addition Software, new dialogs are opened to

proceed with installation for these softwares.
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11. Results

Installation results are listed here. Please note if any errors are shown.

Click [OK] button to complete the installation.

E! Renesas e’ studio 2020-04 Setup

Renesas e’ studio 2020-04 Setup

Welcome Installation of e2 studio is complete.
PETTE(FTILE Please click OK to close.
Extra Features

Customise [ Launch e? studio?
Features View Release Notes?

Additional View What's New?
Software

Licenses
Shortcuts
Summary

Installing...

[ Resuits |

v202004121319 < Back Next >

O

RENESANAS

Cancel

X

Figure 2-10 Installation of 64-bit e? studio — Results
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2.2

Installation of e? studio IDE (32-bit version)

1. Double-click on e? studio installer to invoke the e studio installation wizard page. Click [Install].

Note: If €2 studio was installed in your PC, the option to modify, remove the existing version or install e?
studio to a different location will be displayed. If you would like to have multiple versions of e? studio,
please specify “Install to a different location” here. Click the [Next] button to continue.

[EM e studio Setup (] X
2 .
e” studio 7.8.0.R20200321-2326 Setup . IE NESAS
e2 studio is already installed.
What do you want to do?
___Upgrade
"\l;/" Upgrade to version 7.8.0.R20200321-2326.
Location: C:\Renesas\e2_studio7 7
_Modify
‘.\'!'/.‘ Add or remove features in the existing installation.
Location: C:\Renesas\e2_studio 7_8
. Remove
‘.\)_(/.‘ Uninstall the existing version.
Location: C\Renesas\e2_studio_7_8
— Install
“— Install to a different location.
v202003220126 < Back Next > Install Cancel
Figure 2-11. 32-bit e? studio installation wizard
2. Welcome page
Click the [Next] button to continue.

& e? studio Setup O X
e? studio 7.8.0.R20200321-2326 Setup - zE N ESAS
Welcome Welcome to the e® studio installation wizarcl. This wizard will guide you through the

installation process.
Click Next to proceed to the next page.
Click Back to change something on a previous page.
Click Cancel to cancel this installation at any time.
Configure Proxy Settings...
v202003220126 < Back | Install Cancel

Figure 2-12. Welcome page of 32-bit installer

R20UT4535EJ0102 Rev 1.02
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3. Install Folder

The default installation location is set to: C: \Renesas\e2 studio. Enter the install folder directly into
the textbox or click the Browse... button to modify it. Click the Next button to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.
Note2: Multi-byte characters cannot be used for e? studio installation folder name.

&M 2 studio Setup O 5 e

2 .
e* studio 7.8.0.R20200321-2326 Setup .ZEN ESAS
* Welcome Where would you like to install?

Install Folder | C\Renesas\e2_studio

& Restore Default | | [J Browse...

v202003220126 < Back Install Cancel

Figure 2-13. Installation of 32-bit e? studio — Install Folder
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4. Device Families

Select Devices Families to install. Make sure you tick the checkbox for Support for RZ Devices.

& o2 studio Setup

* Welcome

* Install Folder

e’ studio 7.8.0.R20200321-2326 Setup

Select the device families you wish to install components for

[ AW Support for RA Devices
A Indludes Build, Debug & Code Generation

I Device Families

v202003220126

Support for RZ Devices
I R
RZ

Includes Build, Debug & Code Generation

O @-\ Support for RL78 Devices
RU78 |hdudes Build, Debug & Code Generation
W Support for RX Devices

- X Includes Build, Debug & Code Generation

n W Support for RH850 Devices
RHBSO0 |qydes Debug

Support for Synergy Devices

Renesas Synergy'™
L] yneray Includes Build, Debug & Code Generation

W Support for Renesas RE Devices
Includes Build & Debug

n W Support for RZ/G Devices
Rz Includes Build & Debug Support

Ijl-_-lIE

Select All

< Back

Install

O et
RLENESAS
Cancel

Figure 2-14. Device Families Page (32-bit): Support for RZ Devices
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Note: Support for RZ/G Devices is the option for RZ/G Linux application project generation and debugging.
(Only 32-bit version of e? studio has this option.) If you need to develop applications for Linux on RZ/G
device, please select this too.

&N & studio Setup

e? studio 7.8.0.R20200321-2326 Setup

Select the device families you wish to install components for

* Welcome O @'\ Support for RA Devices
RA Includes Build, Debug & Code Generation
* Install Folder

W Support for RZ Devices

Device Famili
SES LELTIES RZ Includes Build, Debug & Code Generation

u W Support for RL78 Devices
RU78 |qydes Build, Debug & Code Generation

O W Support for RX Devices
R Includes Build, Debug & Code Generation

O @\ Support for RH850 Devices
RHBS50 |ncydes Debug
Support for Synergy Devices

Renesas Synergy™
[ yneray Includes Build, Debug & Code Generation

O W Support for Renesas RE Devices
RE Includes Build & Debug

| X

RENESAS

W Support for RZ/G Devices
RZ Includes Build & Debug Support

Select All

v202003220126 < Back

Install Cancel

Figure 2-15. Device Family Page (32-bit): Support for RZ/G Devices
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5. Extra Components
Select the required extra components (e.g. language packs, SVN & Git support, RTOS support...).
For example, select RTOS if using a RTOS such as FreeRTOS or OpenRTOS.
Click the Next button to continue.

EA e? studio Setup O X
e? studio 7.8.0.R20200321-2326 Setup - 2 E N ESAS
* Welcome M E Japanese Language Pack
% Install Folder Provides Japanese language support
5 . - Chinese (Simplified) Language Pack
Bxiellanilcs u E Provides Simplified Chinese language support
Extra Components . .
] E Chinese (Traditional) Language Pack
Provides Traditional Chinese language support
H Collaboration
Includes SVN & Git support
E RTOS
FreeRTOS & OpenRTOS Debug Support
n E Terminals
ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet

Select All | Deselect All

v202003220126 < Back Install Cancel

Figure 2-16. Extra Components Page (32-bit): RTOS is selected
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6. Components

The components needed by the selected Device Families, are automatically selected.
Please check the selected components and then click the Next button to continue.

EA &2 studio Setup

= Welcome

* Install Folder

* Device Families

* Extra Components

Components

v202003220126

e? studio 7.8.0.R20200321-2326 Setup

Select the components you want to install and deselect the components you do not want to install.

=i Required Components
Renesas e2 studio

Renesas e2 studio Common Core
Renesas e2 studio Commor

IAR Plugin Manager
IAR Plugin Man
and debugger plugins

er simplifies installa

=3 Optional Components

GCC for Renesas RZ Build Support

GCC for Renesas RZ Build Support

Renesas RZ Debug Support
Renesas RZ Debug Support

Renesas e2 studio Common Build

ommon Build

Renesas C

Renesas e2 studio Common Build for GCC Toolchains

Renesas e2 studio Common Build for GCC Toolchains

Select All Optional | Deselect All Optional

I < Back I Next > I

O X
RENESAS

Install

Around 774.5 MB required

Cancel

Figure 2-17. Components Page (32-bit e? studio)
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7. Additional Software
Check that additional software (i.e. GCC ARM Embedded (it is same with GNU ARM Embedded toolchain)
and LibGen for GCC ARM Embedded) are selected. The additional software list is automatically populated
according to the selected device families. The selected software’s installer will be invoked by the e? studio
installer (for more information, see chapter 2.3). If you want to use a version of GCC ARM Embedded which
is not included in the list, please download and install it separately (see chapter 1.3). Click the Next button

to continue.
EA &2 studio Setup O X
e® studio 7.8.0.R20200321-2326 Setup IQE N ESAS
Select additional software to be installed
* Welcome Toolchains & Utilities (4)
* Install Folder & GCC ARM Embedded s
* Device Families GCC ARM Embedded 4.9 2015q3
* Extra Components GCC ARM Embedded 4.9 201593
[ size: 63.7 MB

* Components

Additional Software GCC ARM Embedded 6 20172

2017a2

LibGen for GCC ARM Embedded
LibGen for GCC ARM Embedded (requires GCC ARM Embedded toolchain
Dow 7.6 MB

Dow

v

216.8 MB download required

v202003220126 < Back Install Cancel

Figure 2-18. Additional Software Page (32-bit e? studio)
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8. License Agreement

Read and accept the software license agreement by selecting the Next button.

Please note that you have to accept the license agreement, otherwise installation cannot be continued.

A & studio Setup

* Welcome

*/ Install Folder

*) Device Families

* Extra Components
* Compenents

* Additional Software

Licenses

e’ studio 7.8.0.R20200321-2326 Setup

Please read and accept the following Software Agreements

Eclipse Foundation Software User Agr...
Eclipse Foundation Software User Agr...
License Terms and Conditions for REM...

IAR Plugin Manager

O X

RENESAS

STATEVIEWER LICENSE AGREEMENT ~
ATTENTION: PLEASE READ THIS DOCUMENT
CAREFULLY BEFORE INSTALLING

THE SOFTWARE. THE INDIVIDUAL OR ENTITY
INSTALLING THIS SOFTWARE

(THE "USER") AGREES TO BE BOUND BY THE TERMS

OF THIS LICENSE.

IF YOU DO MOT AGREE TO THE TERMS OF THIS
LICEMSE, DO NOT INSTALL

OR USE THE SOFTWARE.

This License Agreement (the 'Agreement’) is entered
into at the

date of installation of the Software (the 'Effective

Date') by

and between the USER and WITTEMNSTEIN aerospace

& simulation Itd,

a corporation registered under the laws of England

and trading hd

1 accept the terms of the Software Agreements: I

v202003220126 < Back Mext = Install Cancel
Figure 2-19. Additional Software Page (32-bit e? studio)
9. Shortcuts
Select a shortcut name for the start menu and click the Next button to continue.
EN & studio Setup O *

* Welcome

* Install Folder

* Device Families

* Extra Components
* Components

* Additional Software

* Licenses

202003220126

" studio 7.8.0.R20200321-2326 Setup

RENESAS

Shortcuts to impertant programs and files will be created in the following locations:

In start menu group:

Renesas Electronics e2studio

< Back

@ Restore Default

Install Cancel

Figure 2-20. Shortcuts Page (32-bit e? studio)
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10. Summary

Click the Install button to install the Renesas e? studio IDE.

B € studio Setup

Welcome

Install Folder
Device Families
Extra Components
Components
Additional Software
Licenses

Shortcuts

Summary

v202003220126

e’ studio 7.8.0.R20200321-2326 Setup

m|

LENESAS

*

Review the information and click Install to continue.

Required Software that will be installed:
None

Components that will be installed:
Renesas e2 studio (7.8.0.R20200321-2326)
Renesas e2 studio Common Core (6.12.0.v20200305-1438)
IAR Plugin Manager (1.1.0.201906261345)
GCC for Renesas RZ Build Support (7.8.0.v20200313-1056)
Renesas RZ Debug Support (7.8.0.v20191127-2112)
Renesas e studio Commeon Build (6.10.0.:20200313-1019)
Renesas g2 studio Common Build for GCC Toolchains (6.8.2.v20200312-1245)
Renesas e2 studio Memory Usage View (6.11.0.,20200224-1628)
Renesas e2 studio Stack Analysis View (6.9.0.~20200305-0646)
Renesas e2 studio Common Debug (6.10.1.v20200312-1118)
Renesas e2 studio ARM Common Debug (6.11.0.20200312-0639)
Renesas Debug Views (6.11.0.+20200312-0842)
Renesas Smart Help (6.11.0.v20200206-0641)
GCC for Renesas RZ Support Files (1.1.7.v20200311-1145)
Renesas RZ Debug Support Files {1.11.0.20200322-0311)
Renesas e2 studio Optimization Assistant (1.5.6.w20191125-1406)
Renesas e? studin Conflicts Checker (6.0.1.020191120-144/)

= Back Cancel

| Install |

Figure 2-21. Summary Page (32-bit e? studio)

11. Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. Please see chapter 2.2 for more detailed information.

12. Results

Click the OK button to complete the installation.

EA e studio Setup

eZ

0

Welcome

-

Install Folder

-

Device Families

-

Extra Components

-

Components

Additional Software

-

-

Licenses

-

Shortcuts

-

Summary

-

Installing...

Results

v202003220126

studio 7.8.0.R20200321-2326 Setup

|

LENESAS

X

Installation of e2 studio is complete. Please click OK to close.

[ Launch e2 studio?
[v] View Release Notes?
View What's New?

< Back Next > Cancel

Figure 2-22. Summary Page (32-bit e? studio)
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2.3 Installation of Additional Software

The e? studio installer invokes other installers which were selected within the Additional Software pane (such
as GNU Compilers or Libgen Update for GNU ARM Embedded Toolchains).

2.31 GNU ARM Embedded Toolchain

If it was selected in the Additional Software pane of e? studio, you will see the installation wizard for the GNU
ARM Embedded Toolchain during the installation process.

1. Click Next.
2. After reading the license agreement, click | Agree.
3. Select the destination folder. The default folder is recommended.

4. Atthe end of the installation, you can select options such as adding the path to the Windows environment
variable, and adding registry information.

{7 GNU Tools for ARM Embedded Processors 6-2017-g2-update — # |43 GNU Tools for ARM Embedded Processors 6-2017-q2-update — *
License Agreement p
Welcome to the GNU Tools for ARM Please review the license terms before instaling GNU Tools for ARM Embedded R 9 y
Embedded Processors Processors 6-2017-q2-update 6 2017,
6-2017—q2-update 6 2017 Setup
Wizard

Press Page Down to see the rest of the agreement.
This wizard will guide you through the installation of GNU
Tools for ARM Embedded Processors 6-2017-g2-update 6
2017, Contains code from project GMU Binutils (https: w.anu.org/software binutils /),

GMU Debugger (httos:/fwww.anu.org/software/gdb /) under the following license(s).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update

relevant system files without having to reboot your GMU GEMERAL PUBLIC LICENSE
Computer. ersion 3, 29 June 2007
Click Mext to continue. Copyright (C) 2007 Free Software Foundation, Inc. <http:(/fsf.org/=
Everyone ig permitted to copy and distribute verbatim copies
of this license document, but changing itis not allowed. W

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install GNU Toals for ARM Embedded Processors 6-2017-q2-update 6 2017,

2
(31 GNU Tools for ARM Embedded Processors 6-2017-q2-update — |43 GNU Tools for ARM Embedded Processors 6-2017-g2-update —

Choose Install Location

Choose the folder in which to install GNU Tools for ARM Embedded Processors R g ’
6-2017-g2-update & 2017,

Completing the GNU Tools for ARM
Embedded Processors
6—-2017—q2-update 6 2017 Setup
Wizard

GMNU Tools for ARM Embedded Processors 6-2017-g2-update
& 2017 has been installed on your computer,

Setup will install GNU Tools for ARM Embedded Processors 6-2017-g2-update 6 2017 in the
following folder. To install in & different folder, dick Browse and select another folder. Clidk
Install to start the installation.

Click Finish to dose this wizard, 4

Launch gcovar.bat
[] Add path to environment variable
Add registry information

Destination Folder

Browse...

Space required: 433.3MB
Space available: 8.3GB

< Back Cancel

< Back Install Cancel

Figure 2-23. Installation of GNU ARM Embedded Toolchain
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2.3.2 Libgen Update for GNU ARM Embedded Toolchains

If it was selected in the Additional Software pane of e? studio, you will see the installation wizard for the Libgen
Update for GNU ARM Embedded Toolchains during the installation process. If you do not wish to update the
GNU ARM Embedded Toolchain, terminate the Libgen Update for GNU ARM Embedded Toolchains by

clicking the * (close) button.
1. Click Click here to select your GNU ARM Embedded Toolchain installation folder.

2. Select the folder for the GNU ARM Embedded Toolchain to update.

w Libgen Update for GNU ARM Embedded Toolchains - X

Libgen Update for GNU ARM Embedded Toolchains

Version 1.2018.02
Copyright ¢ 2017-2018 CyberThor Studios Ltd. All Rights Reserved.

Click here to visit our support platform at gcc-renesas.com

Click here to visit our website O UIII:RTHIIR
Srudios

This Libgen update installer will be making changes to your existing GNU ARM Embedded Toolchain installation(s). We
recommend that you only apply this update to GNU ARM Embedded release 5-2016-qgl-update or later, to avoid
incompatibilities.

Click here to download the GNU ARM Embedded Toolchain installer(s)

[ Toolchain folder not selected. Please select the toolchain folder to continue. ]
1 I Click here to select your GNU ARM Embedded Toolchain installation folder... I

Install Libgen Update for GNU ARM Embedded Toolchains

W Libgen Update for GNU ARM Embedded Toolchains —

Libgen Update for GNU ARM Embedded Toolchains

Version 1.201|Browse for Folder b4
Copyright c 2 Reserved.
Current folder:

Click here to m

Click here to vid C:¥...¥GNU Tools ARM Embedded¥6 2017-g2-update ) tyg[a‘[l-ma
Adobe ~ Srudios
Atmel
Citrix

dded Toolchain installation(s). We
16-ql-update or later, to avoid

This Libgen update installer will be
recommend that you only apply

Commen Filas
DaUM
e-stamp_pro

Click here nstaller{s)

P017-q2-update

¥ | infolder.. |

C:\Program File

| Click herg

Mewy folder Cancel
Install Libgen Update for GNU ARM Embedded Toolchains

Figure 2-24. Libgen Update for GNU ARM Embedded: Select Toolchain Folder
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3. Next, click Install Libgen Update for GNU ARM Embedded Toolchains.

‘& Libgen Update for GNU ARM Embedded Toclchains - X

Libgen Update for GNU ARM Embedded Toolchains

./ Version 1.2018.02
& Copyright ¢ 2017-2018 CyberThor Studios Ltd. All Rights Reserved.

Click here to visit our support platform at gcc-renesas.com

Click here to visit our website {4 t'!ERTHUR
STudios

This Libgen update installer will be making changes to your existing GNU ARM Embedded Toolchain installation(s). We
recommend that you only apply this update to GNU ARM Embedded release 5-2016-ql-update or later, to avoid
incompatibilities.

Click here to download the GNU ARM Embedded Toolchain installer{s)

| C:\Program Files (x86)\GNU Tools ARM Embedded\6 2017-q2-update |
| Click here to select your GNU ARM Embedded Toolchain installation folder.. |

Install Libgen Update for GNU ARM Embedded Toolchains

| ¥ Libgen Update for GNU ARM Embedded Toolchains — *

Libgen Update for GNU ARM Embedded Toolchains

.~ \Version 1.2018.02
& Copyright ¢ 2017-2018 CyberThor Studios Ltd. All Rights Reserved.

Click here to visit our support platform at gcc-renesas.com

Click here to wisit our website o U’IERTHUR
STudIDS

Libgen Update Completed x

o Installation completed successfully!

s

Figure 2-25. Libgen Update for GNU ARM Embedded: Update Toolchain

If you want to update another toolchain, download Libgen Update for GNU ARM Embedded separately
and run it (refer to Chapter 1.4).
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24 Uninstallation of the e? studio IDE

The e? studio IDE can be uninstalled by following the usual steps to uninstall a program in a Windows OS.

1. Search for Apps & features in the Windows Search Box. Click on the search result to go to Apps & features.
2. From the currently installed programs list, choose ‘e2 studio’ and click the Uninstall button.

3. Click the Uninstall button again to confirm the deletion of e? studio.

At the end of the uninstallation, the e2 studio IDE will be deleted from the installed location and Windows shortcut
menus will be removed.

25 Major Version Upgrade for the e? studio IDE

The Check for Updates operation does not work for major version upgrades (a major digit version number
increase, for example from version @.3.0 to version .0.0), you need to use the e’ studio installer for major
upgrades. Please note that you should not overwrite the existing installation. Before installing the new version,

you must uninstall the old one. However, to keep both the old and new IDE versions, you can install the new
version to a different location.

2.6 Update e? studio plugins

The e? studio IDE supports online and offline updates for minor version updates (i.e. minor digit number
increases, for example going from version 7. to version 7.). This allows the available software
components to be updated over the internet or without an internet connection.

2.6.1 Online Minor Version Update
This chapter shows how to perform a minor version update online:

1. From the Help menu, click Check for Updates to display the Available Updates panel.

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
s | @ Welcome & Welcome
@ Help Contents
% Search
Show Contextual Help

Welcome to e2 studio

Show Active Keybindings... Ctrl+Shift+L
Cheat Sheets...

RenesasRulz Community Forum

Add Renesas Toolchains

Perform Setup Tasks...

Check for Updates I

Install New Software...

Renesas e2 studio feedback

Create a new e? studio C/C++ project |

] & v N

i

IAR Embedded Workbench plugin manager...

@

Import existing e2 studio projects from the About e® studio

filesystem or archive

Try out the samples

Review the IDE's most fiercely contested DAIways show Welcome at startup \s

preferences
Figure 2-26. Check for Updates Menu
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2. All the software components are selected by default in the Available Updates panel. This allows you to
update them all to the latest version (an example is shown in Figure 2-2). Click the Next button to proceed.

Available Updates
Check the updates that you wish to install.

GCC for Renesas RLV3 Build Support
GCC for Renesas RX Build Support
GCC for Renesas R Support Files
GCC for Renesas RZ Build Support
Renesas CCRL Build Support
Renesas CCRL C8+ Import/Export
Renesas CCRL Support Files
Renesas CCRX Build Support
Renesas CCRX CS+ Import/Export
Renesas CCRX HEW Import
Renesas CCRX Support Files

Version

6.1.0:20171017-0...
6.1.0:20171010-0...
1.1.0:20171010-0...
6.1.0020171011-1...
6.1.0:20170027-0...
6.1.0:20170027-0...
1.0.1.v20170012-0...
6.1.0:20170913-1...
6.1.0:20170913-1...
6.1.0:20170913-1...
1.0.1.:20170912-0...

Id

com.renesas.estudio.devicerl78.build.g...
com.renesas.elstudio.device.xbuild.gcc..
com.renesas.idesupportfiles.rgec.featu..
com.renesas.elstudio.device.rz.build.gcc..
com.renesas.e2studio.devicerl78.build re...
com.renesas.elstudio.devicerl78.build re...
com.renesas.idesupportfiles.rl78.corl feat...
com.renesas.estudio.device.ncbuild.ren...
com.renesas.estudio.device.ncbuild.ren...
com.renesas.estudio.device.ncbuild.ren...
com.renesas.idesupportfiles.noconcfeatu..,

Select All

Deselect All

Details

< Back

Mext = Finish

Cancel

Figure 2-27. e? studio — Available Updates Panel (1/3)

3. Select the Next button to continue the update.

Update Details

Review and confirm the updates,

MName

[ GCC for Renesas RX Build Support
[ GCC for Renesas RX Support Files
or Renesas uild Support

[ GCC for Ry RZ Build Supp

(§* Renesas CCRL Build Support
Enesas + Import/Export

@R CCRL C5+ Import/Exp
Enesas upport Files

@R CCRL Support Fil

[ Renesas CCRX Build Support
Enesas + Import/Export

R CCRX C5+ Import/Exp

[ Renesas CCRX HEW Import
Enesas upport Files

@R CCRX Support Fil

[+ Renesas Debug Views

[ Renesas e2 studio

Size: 183,587 KB
Details

GCC for Renesas RL78 Build Support
pp

(L Remarar &) churdin ARM Camman Nehie

Version

6.1.0v20171011-0631
6.1.0.v20171010-0849
1.1.0v20171010-0832
6.1.0%20171011-1311
6.1.0.v20170927-0303
6.1.0.v20170927-0303
1.0.1.%20170912-0749
6.1.0.v20170913-1022
6.1.0.v20170913-1022
6.1.0.v20170913-1022
1.0.1.%20170912-0755
6.1.0.v20170928-0927

6.1.0.R20171011-1340
£ 1NN 71NN NGNS

< Back

Mext > Finish

Id

com.renesas.elstudio.devicerl78.b...
com.renesas.elstudio.device.ncbui...
com.renesas.idesupportfiles.nege..

com.renesas.elstudio.devicerz.bui..
com.renesas.elstudio.devicerl78.b...
com.renesas.elstudio.devicerl78.b...
com.renesas.ide.supportfiles.rl78.c...
com.renesas.elstudio.device.ncbui...
com.renesas.elstudio.device.ncbui...
com.renesas.elstudio.device.ncbui...
com.renesas.ide.supportfiles.neccr..
com.renesas.e2studio.debug.views...

com.renesas.ide.e2studio.product

ram ranacar alotudia devica arm

Cancel

>

Figure 2-28. e? studio — Available Updates Panel (2/3)
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4. Read and accept the software license agreement. Click the Finish button to complete the update.

Licenses must be reviewed and accepted before the software can be installed.

Review Licenses
A
B .
o=

Licenses: License text:
A.HISTORY OF THE SOFTWARE Eclipse Foundation Software User Agreement A
» Eclipse Foundation Software User Agreement April §, 2074
i
cense Usage Of Content

License for REMESAS &2 studic

Renesas Pin Configurator THE ECLIPSE FOUNDATIOM MAKES AVAILABLE SOFTWARE,
DOCUMENTATION, INFORMATION AND/OR

OTHER MATERIALS FOR OPEN SOURCE PROJECTS (COLLECTIVELY
"CONTENT"),

USE OF THE CONTENT IS GOVERNED BY THE TERMS AND
CONDITIONS OF THIS

AGREEMENT AND/OR THE TERMS AND CONDITIONS OF LICENSE
AGREEMENTS OR

NOTICES INDICATED OR REFERENCED BELOW. BY USING THE
CONTENT, ¥OU

()| accept the terms of the license agreements I

(®) | do not accept the terms of the license agreements

® < Back Mext = Cancel

Figure 2-29. e? studio — Available Updates Panel (3/3)

5. Click the Help = About e? studio menu option to check the version number and verify the update.

&) About €2 studio O X
Renesas e” studio 2
Version: 2020-04 (20.4.0)
Build Id: R20200412-1149
Parts Copyright (C) 2010-2020 Renesas Electronics Corp.
All rights reserved.
e? studio IDE is an extension of software developed for
eclipse.org.
e? studio IDE is based on Eclipse Platform 4.14 (2019-12)
and CDT version 9.10.0.
Source code for the Eclipse Foundation plug-ins is available
from www.edipse.org, under the Eclipse Public License "EPL",
see https://www.eclipse.org/org/documents/epl-2.0/EPL-2.0.html
and https://www.eclipse.org/org/documents/epl-v10.html v
A g)
cCEEEOR S A
@ | Installation Details

Figure 2-30. e? studio — About e? studio Panel

R20UT4535EJ0102 Rev 1.02 RENESAS Page 27 of 79
24 Sep, 2020



e? studio Getting Started Guide User's Manual

2.6.2  Offline Minor Version Update
This chapter shows how to update e? studio using the update function of the installer.

1. Download the desired new version of e? studio offline installer from the following Renesas URL:
http://www.renesas.com/e2studio_download

Note: Offline update using the ‘Differential Update Program’ is only applicable for e? studio
version 3.X and below.

2. Double-click to run the installer file downloaded in step 1. The installer will detect the existing version and
you can choose to upgrade the current version, or install the new version of e? studio to a different folder.

3. Click Upgrade followed by Next to start the update.

& e? studio Setup O X

e? studio 7.8.0.R20200321-2326 Setup - zE N ESAS

e2 studio version 7.7.0.R20191216-1445 is already installed.

What do you want to do?

@ Upgrade
Upgrade to version 7.8.0.R20200321-2326.

/— Install
“— Install to a different location.

v202003220126 < Back Next > Install Cancel

Figure 2-31. Upgrade e? studio from Offline Installer

4. Follow the steps shown in Chapter 2.1 Installation of e? studio IDE. Step 2 Install Folder will be skipped
since the upgrade option will use the same destination folder as the existing e? studio installation.
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2.7 Register Toolchain to e? studio

The e? studio installer can install toolchains (such as GCC ARM

Embedded) automatically during e? studio

installation with a valid Internet connection. However, in situations where an Internet connection is not available
during e? studio installation, toolchains that are needed can be installed later by using installer files from the
web site and then registered to e? studio. For the toolchain download site for RZ, please refer to chapter 1.3.

e? studio scans for installed toolchains on start up. After a new toolchain installation, e? studio will pop up a

toolchain integration window to allow for toolchain selection.

Toolchain Integration

(i) Mew toolchains available for integration

Toolchain Registry

v GCC ARM Embedded

Select all Deselect all

Enable ‘Toolchain integration' on startup

Toolchain Type Installation Path

GCC ARM Embedded - 4.9.3.20150529 C:\Program Files (x88)\GNU Tools ARM Ei

Figure 2-32. e? studio Toolchain Integration

To check for installed compilers, click the Integrate non-integrated toolchains icon from the toolbar, or click
Help > Add Renesas Toolchains to open Renesas Toolchain Management as shown below.

Check the desired toolchain to integrate it with e? studio.

4 Debug 7 Tutorial HardwareDebu \=? A |® @

o

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

Welcome

Help Contents
Search
Show Contextual Help

Show Active Keybindings... Ctrl+Shift+1
Cheat Sheets...

RenesasRulz Community Forum

Add Renesas Toolchains |

o Y

LT

Perform Setup Tasks...
Check for Updates

Install New Software...
Renesas e2 studio feedback

‘ Integrate non-integrated toolchains

IAR Embedded Workbench plugin manager...
About e? studio

Figure 2-33. e? studio Add Renesas Toolchains
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If the desired toolchain is not listed, Click Add... and specify the location where it is installed.

<

e e

Location: H

type filter text

Renesas Toolcha ~

Smart Browser
Smart Configura
Smart Manual
Support Folders
Tracealyzer
TraceX
Task Tags
Template Default Va

Help

Install/Update

Java

Library Howver

LinkerScript

MCU

Qomph

Remote Development

Renesas OF

Run/Debug

Scripting

Team

Terminal

Tracing

@®

Renesas Toolchain Management

Scan for installed toelchains on startup

[] Disable warning if ne toolchains are installed

Toolchain Type

Installation Path

w [] GCC ARM Embedded

[ 4.9.3.20150529

C\Program Files (x26)\GMNU Tools ARM Embedded\4.9 2013934

[] KPIT GNUARM-NOME-EABI Teelchain

Scan...

e U L IS A O S YL L e L

|| Integrate a new toolchain which is not already registered.

[GNU] e.g. <Toolchain_Path>\GNURXv12.02-ELF\rx-elf
[Renesas] e.g. <Toolchain_Path>\RX\1_2_1

Add

e uprauiey

Remove

Apply and Close

‘I Browse I

@)

OK Cancel

Browse For Folder

Cancel

Scan...

Add...

ms y=| Tasks [l Console [T] Properties :*0 Call Hierarchy | ‘@ Smart Browser 53 | [l Men

Remove

Apply and Close

4.9 2015g3
\I 6 2017-q2-update

DAUM

e-stamp_pro

ffftp

GNU Tools ARM Embedded

arm-none-eab
bin

lib

share

Google

Folder:

6 2017-q2-update

Make New Folder

Fr =5

Figure 2-34. Toolchain Management: Register New Toolchain
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3. Import/ Generate Project

This chapter describes how to import existing projects (such as sample code in software packages) and how to
generate a new project.

Note: Multi-byte characters cannot be used for the e? studio installation folder name, project name,
project folder, or source file names.

3.1 Import Existing Project

Renesas provides various useful sample projects in the RZ device software package. These sample projects
can easily be imported into e? studio. You can also import your own projects this way.

1. Download the software package.

2. Open the Import dialog with a click on “Import projects...” link in Project Explorer (if there is no projects in
the workspace) or select the menu File > Import.

Eile |Edit Source Refactor Navigate Search Project Rer
New Alt+Shift+N >
Open File...
L2 Open Projects from File System...
Recent Files >
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+S
1 Project Explorer 2 &y § =0 Save As...
Save All Ctrl+Shift+S
There are no projects in your workspace. Revert
To add a project:
. o . Move...
Create a new Makefile project in a directory
o L . Rename... F2
containing existing code
. ] Refresh F5
& Create a new C or C++ project . o
Convert Line Delimiters To >
™ Create a project...
I\ I : — I Print... Ctrl+P
1 |mport projects...
i Export...
Properties Alt+Enter

Figure 3-1. Import Menu
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3. Select General > Existing Projects into Workspace and click Next.

4. Select the folder or project archive file then click Browse and select the project folder in the workspace.

select Import Projects ar
|
c ¢ hive fil q Select a directory to search for existing Eclipse projects.
reate new projects from an archive file or dire
) Select root directory: Browse...
Select an import wizard:
| | (®) Select archive file: Browse...
Projects:
1 Existing Projects into Workspace
ILIE e gt 2 P I RZ_A1H_Tutorial_RSK (an_r01an2511eg0200_rza1h_rsk/Workspace/RZ_ ~ Select All
4 File system T TRZ A1H USB_Host Func RSK (an r01an2511eg0200 rzalh rsk/Worksy Deceloct Al
H esele
= GNUARM-NONE/RZ(DS-5) project co ] RZ ATH_VDC5_RSK (an_r01an2511eg0200_rza1h_rsk/Workspace/RZ_A =
T Preferences v Refresh
. . < >
£ Projects from Folder or Archive
& Rename & Import Existing C/C++ Proj Options
= Renesas CCRX project conversion to R SemilErres E ErEe
® Renesas CS+ Project for CA78KOR/CA] — =Py Prejects into workspace
% Renesas CS+ Project for CC-RX and C [] Clase newly imported projects upon completion
&R GitHub A EreeRTOS P [] Hide projects that already exist in the workspace
enesas GitHub Amazon Free I
& C/CH+ Working sets
& Install [] Add project to working sets New...
E— Select...
® [k [ wee> || o < ock et > Cancel

Figure 3-2 Select Folder or Archive File Included Project Files

5. Projects generated by legacy e? studio (before V6.0) will need to be upgraded.

Click the Project Upgrade Required pop-up message (continued on the next page).

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

# Debug | FICORTEX_ A9_RZ R7S72 ¥ | on: |- v P |® v & ~ @inik v :
Erav iy ryidrQvi®my v 2 LRI 2 > | r# Q % | BC/C++ ¥ Debug
& Project Explorer BSY & =0 = 0 %= outline 2 § =0

& RZ_ATH_Tutorial_RSK 3 3 5
There is no active editor

that provides an outline.

Problems 2 Console # @ Smart Browse Memory Usage 0 Memory -

B R% BRpEEE Dy
<terminated > Tutorial HardwareDebug [Renesas GDB Hardware Debugging] Renesas GDB server (Host)

Click

Project Upgrade Required -

Projects in this workspace require upgrading before they can build
> Click here to upgrade these projects.

Figure 3-3. Project Upgrade
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Alternatively, run Upgrade Legacy e2 studio Projects... from the project right-button context menu.

File Edit Source Refactor Navigate [E Copy Ctrl+C
 Debug ] Paste Ctrl+V
E@vﬁ’vgv@:v;gquvgxzdete Delete
ource 5
i % BSY § <
&3 Project Explorer e

I‘ZC RZ A1H Tutorial RSK |Releas’
Rename... F2

=1 Import...
1 Export...
I 1 Upgrade Legacy e2 studio Projects... I

Build Project

Clean Project
21 Refresh F5
Close Project

Close Unrelated Project

Figure 3-4. Manual Project Upgrade

6. Select the projects to upgrade and click Finish (Figure 3-5).

Upgrade Legacy e2 studio Projects

Select projects to upgrade

[} RZ_ATH_Tutorial RSK [Relea...

Figure 3-5. Migration Required Dialog Box
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3.2 New Project Generation

When creating a new project, the method of creating the project differs between RZ/A2M and other RZ groups.
This chapter explains how to generate a project for each device.

3.21 Project Generation of RZ/A2M

This chapter illustrates an example when using the RZ/A2M Evaluation Board Kit. The RZ/A2M project type can
be selected from ‘Loader Project’ or ‘Application Project’. On the RZ/A2M, both types of project need to be built
and downloaded when debugging.

A ‘Loader Project’ is a project for generating a loader program, and an ‘Application Project’ is a project for
creating a user application program. A ‘Loader Project’ sets the serial flash memory of the RZ/A2M Evaluation
Board Kit so that it can be accessed at high speed, and then branches to the ‘Application Project’ (if the loader
program has not been downloaded, the application program cannot be executed).

When using it on your own system, change the program according to the specifications of the serial flash
memory being used.

To create a new project, launch the e? studio IDE from the Windows start menu and specify a workspace
directory.

1. Click File > New - C/C++ Project to open the New Project Creation Wizard.

File Edit 5Scurce Refactor Mavigate Search  Project RenesasViews Run Window  Help
[ New Alt+Shift+N > | [ RZ Linux C/C++ project
Open File... [c] Makefile Project with Existing Code
[} Open Projects from File System... [@ C/C++ Project ]
— X
Close Crl+W [ tmesi=

Figure 3-6. Open New Project Creation Wizard
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2. Select the template for the new project (for example Renesas RZ: GCC for Renesas RZ C/C++ Executable
Project). Click Next to proceed.

Templates for New C/C++ Project

Al [ GNU for Renesas RZ C/C++ Executable Project

CMake Faz A C/C++ Executable Project for Renesas RZ using the GNU ARM

Make Embedded toolchain.

Renesas Debu - -

Renesas RE J GNU for Renesas RZ C/C++ Library Project

Renesas RL78 EE== A C/C++ Library Project for Renesas RZ using the GNU ARM
Embedded toolchain.

Renesas RX

Renesas RZ

@

< Back Finish Cancel

Figure 3-7. Select Project Template

3. First, create a loader project. Enter the project name (‘Loader’). Click Next to proceed.

New GCC for Renesas RZ Executable Project
Mew GCC for Renesas RY Executable Project |

Project name: |Lc>ader| |

Working sets

[] Add project to working sets

Use default location

C¥Workspace¥Loader

Browse...
Create Directory for Project
default
New...
Select...

< Back Finish Cancel

Figure 3-8. Specify Project Name
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4. Select the following settings:
+ Language: ‘C
*  Toolchain: ‘GCC ARM Embedded’
. Toolchain Version: ‘6.3.1.20170620’
»  Target Device: ‘R7S921053’
*  Project Type: ‘Loader Project’

Select Create Hardware Debug Configuration and then J-Link ARM. Click Next to proceed.

New GCC for Renesas RZ Executable Project ==
Select toolchain, device & debug settings R
Toolchain Settings
Language: ®C OC++
Toolchain: GNU ARM Embedded v
Toolchain Versiong 6.3.1.20170620 v

Manage Toolchains...
RTOS: None b
RTOS Version:
Device Settings Configurations
Target Devicel | R75921056 Create Hardware Debug Configuration
Unlock Devices... J-Link ARM N
ST Liiice ¥ [ create Release Configuration
Project Type:ILoader Project l b
@ < Back [ Next > ] | Finish | Cancel

Figure 3-9. Select Toolchain, Device & Debug Settings: e.g. RZ/A2M Renesas Starter Kit

5. Click Next to proceed because Loader Projects do not support Smart Configurator.

New GCC for Renesas RZ Executable Project

Select Coding Assistant Settings

Use Smart Configurator :

Use Peripheral Code Generator
The e2 studio peripheral code generator and smart configurator automatically generates programs (device
drivers) for MCU peripheral functions (clocks, timers, serial interfaces, A/D converters, DMA controllers, etc.)
based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APls) and are not limited to initialization of peripheral functions.

Automatic
UART Ti generation Application under
csl imer of peripheral development
WD function | Software
DA | Port D | [ Middleware
r 4 Devica L= e
DMA | Clock dmer | RTOS |

@ < Back Finish Cancel

Figure 3-10. Select Coding Assistant Settings
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6. In the initial settings, USB and RTC are not used. In ‘Loader Project’, click Next to proceed.

MNew GCC for Renesas RZ Executable Project —
Select Peripheral Usage Options

Select Peripheral Usage Options
[ Use USBO peripheral
[ Use USB1 peripheral
[[]Use RTCO peripheral
[JUse RTC1 peripheral

) < Back I Mext = I | Finish | Cancel

Figure 3-11. Select Peripheral Usage Options

7. Keep default settings for additional CPU options and click Next to proceed.

New GCC for Renesas RZ Executable Project —
Select Additional CPU Options
Select Additional CPU Options
Instruction Set Arm b
[JinterWorking
Target FPU neon b
Floating Point ABI Hard ~
Warn if stack size exceeds the limit, in bytes | 100
@ < Back Next > FEinish Cancel
Figure 3-12. Select Additional CPU Options
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8. Select ‘Project-Built’ and click Next to proceed.

New GCC for Renesas RZ Executable Project

Select library generator settings

Select Library Source:

(D) Optimized (®) Newlib
Use this for further code size optimization.
Select Librany Type:
() Pre-Built

Build the library with user specified options

Next > Einish |

® | |

Cancel

Figure 3-13. Library Generator Settings: Select Project Built

9. A project summary is displayed. Click Finish to generate the project.

New GCC for Renesas RZ Executable Project

Summary of project "Loader”

Device: R75921053

Toolchain Version: £.3.1.20170620

Files added:
generate/system,/
generate/compiler/
generate/drivers/
generate/systemy/
generate/linker_script.ld

@ Bk

MNext >

Cancel

Figure 3-14. New Project Creation Wizard (Summary)
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10. A new C project named ‘Loader" will be created.

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

4 Debug ~| & Loader HardwareDebug ~ Y Slwilg @&~ & ~@inilk « WOE e[y~
v QS IvidRETIHYF YooY v Q E |EBC/C++ * Debug
& Project Explorer & = B B r_startup_configh = 0 E=Qutline # - b
p == P\ 2 ®* DISCLAIMER[] ~ ElEw o %
& Loader [HardwareDebug] 24 #* File Name : r_startup_config.h[] # R_STARTUP CONFIt ~
& Indudes 27 =#ifndef R_STARTUP_CONFIG_H # STARTUP CFG DISA
v @8 generate gg #define R_STARTUP_CONFIG_H # STARTUP_CFG_DIS/
& compiler 30 /* example of configured macro definitions *, # STARTUP_CFG_DIS/
i configuration 31 # STARTUP_CFG_DIS/
& drivers 32 =/* select whether RTCO(secure) use or not # STARTUP_CFG_USB,
& system 33 * @ : Use RTCO (do not touch RTC? in §tartu; # STARTUP CFG BOC
L . 34 * 1 : Not use RTC® (startup routine disable:
2 linker_script.d 35 */ (V] # STARTUP_CFG_PRO w
& src < > < >
— Loader HardwareDebug.IauncL Problems & Console 22 & Smart Browse Memory Usage U Memory A
No consoles to display at this time.
< >
Figure 3-15. New C Project Created
11. Next, create an Application project.
Click File > New > C/C++ Project to open the New Project Creation Wizard.
File Edit Source Refactor Mavigate Search Project Renesas Views Run Window Help
{ New | Al+Shift+M > [T RZ Linux C/C++ project
Open File... [cf Makefile Project with Existing Code
[, Open Projects from File System... [@ C/C++ Project ]
Close Ctrl+W [ Project..
Figure 3-16 Open New Project Creation Wizard
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12. Select the template for the new project (for example, Renesas RZ: ‘GCC for Renesas RZ C/C++ Executable
Project’). Click Next to proceed.

Templates for New C/C++ Project

All
Make

Renesas Debug L Embedded toolchain.

GCC for Renesas RZ C/C++ Executable Project
ez~ A C/C++ Executable Project for Renesas RZ using the GCC ARM

Embedded toolchain.
Renesas Synergy

R RL78
R:::::: "X GCC for Renesas RZ C/C++ Library Project
Renesas - EE= A C/C++ Library Project for Renesas RZ using the GCC ARM

Cancel

Figure 3-17. Select Project Template

13. Now, create the Application Project. Enter the project name (‘Application’). Click Next to proceed.

New GCC for Renesas RZ Executable Project
Mew GCC for Renesas RZ Executable Project]

Project name: IAppIicatiDn I

Use default location
C:¥Workspace¥Application
Create Directory for Project
default

Working sets

[] Add project to working sets

&)

con

Finish

Mew...

Select...

Cancel

Figure 3-18. Specify Project Name
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14. Select the following settings.
* Language: ‘C’ or ‘C++
*  Toolchain: ‘GCC ARM Embedded’
. Toolchain Version: ‘6.3.1.20170620°
»  Target Device: ‘R7S921053’
. Project Types: ‘Application Project’

Select Create Hardware Debug Configuration and then J-Link ARM. Click Next to proceed.

New GCC for Renesas RZ Executable Project

Select toolchain, device & debug settings

Toolchain Settings

N\

C OcC++
GNU ARM Embedded

Language:

Toolchain:

Toolchain Version:{6.3.1.20170620

~

LV

Manage Toolchains...

RTOS: None

RTOS Version:

Device Settings

Target Device:| R75921053

Endian: Little

Project Type: [Application Project]

N

Unlock Devices...

LV

N

Configurations
Create Hardware Debug Configuration
J-Link ARM b

[] Create Release Configuration

@ < Back [

Next >

] | Einish Cancel

Figure 3-19. Select Toolchain, Device & Debug Settings: e.g. RZ/A2M Renesas Starter Kit
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15. The Coding Assistant feature can be selected if required.

Note:

»  Smart Configurator supports a single user interface that combines the functionalities of Code Generator
and FIT Configurator. Smart Configurator encompasses a unified clock configuration view, an interrupt
configuration view and a pin configuration view.

Select Use Smart Configurator, click Next to proceed.

New GCC for Renesas RZ Executable Project —
Select Coding Assistant Settings
|illse Smart Configurato
Use Peripheral Code Generator
The e2 studic peripheral code generator and smart configurator automatically generates programs (device
drivers) for MCU peripheral functions (clocks, timers, serial interfaces, A/D converters, DMA controllers, etc.)
based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APls) and are not limited to initialization of peripheral functions.
ot (o)
User Application 3
1]
~ o =
Driver and Middleware -
= 0
Driver Code | FIT Modules 9
Configured in GUI Selected in GUI =
and Generated and Imported aqa
=
-
(3]
MCU Hardware g
O/
laa R REREERERERERRERR R R RN
@ <Back | Net> [ Enish || cancel

Figure 3-20. Select Coding Assistant Settings

16. In the initial settings, USB and RTC are not used. When using USB and RTC, select the peripheral module
/ channel to be used.

New GCC for Renesas RZ Executable Project —
Select Peripheral Usage Options

Select Peripheral Usage Options
[[]Use USBO peripheral
[JUse USB1 peripheral
[]Use RTCO peripheral
[]Use RTC1 peripheral

@ <Back | Nea> |[ Fnish || Cancel

Figure 3-21. Select Peripheral Usage Options
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17. Keep the default settings for additional CPU options and click Next to proceed.

New GCC for Renesas RZ Executable Project

Select Additional CPU Options

Select Additional CPU Options

Instruction Set Arm
] InterWorking

Target FPU neon

Floating Point ABI Hard

Warn if stack size exceeds the limit, in bytes | 100

@ < Back Finish Cancel

Figure 3-22. Select Additional CPU Options

18. Select Project-Built and click Next to proceed.

New GCC for Renesas RZ Executable Project —

Select library generator settings

Select Library Source:
(O Optimized (@ Newlib

Use this for further code size optimization.

Select Library Type:

() Pre-Built
Build the library with user specified options
@ <Back | Nea> |[ Enish || cancel

Figure 3-23. Select Library Generator Settings
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19. A project summary is displayed. Click Finish to generate the project.

Mew GCC for Renesas RZ Executable Project —

Summary of project "Application”

Devices R75921053

Toolchain Version: 6.3.1.20170620

Files added:
generate/system/
generate/compiler/
generate/configuration/
generate/drivers/
generate/os_abstraction/
generate/sc_drivers/
generate/system/
generate/linker_script.ld

&)

Figure 3-24. New Project Creation Wizard (Summary)

20. Click Open Perspective.

Q Open Associated Perspective? X

ey Open the Smart Configurator perspective?
(2]

[ ] Remember my decision

Open Perspective No

Figure 3-25. Open Associated Perspective Wizard
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21. A new C project named ‘Application’ is created.

File Edit Navigate Search Project Renesas Views Run Window Help
* Debug [ Application Hardwarel iZin~ Ew R owlw BigvQvigw
v i vt v o v |m Q i® | FC/C++ % Debug & Smart Configurator
5 Project Explorer & 5%Y & 78 & Application.... & " = 5 EMCUPa. = = =
(< Application: ) L .
~ (i Application; Overview information He
&l Indludes
v @ generate ~ General Information ® A
= compiler This editor allows you to modify the settings stored in configuration file (.scfc
& configuration
& drivers Clocks
& os_abstraction Allow clock configuration
& sc_drivers
= system
o ) Components
2 linker_script.d
v @ src Allow software component selection and configuration
= renesas
& user_prog Pins
2 Application HardwareDebug.launch Allow general pin configuration and pin configuration for selected software ¢
\_ & Application.scfg y,
= Loader MMU
Allow MMU configuration v
Overview Clocks| Components| Pins MMU
B Console 2 ¥ O ¥ = O {2 Configuration Problems 2 7 &= o
No consoles to display at this time. 0 items
Description - Type

Figure 3-26. New C Project Created

This project consists of an application file 2zpplication.c and a set of automatically generated files. All these
project and source files are listed in the Project Explorer panel reflecting the folder structure of the project, just

as seen in the standard file explorer.

Notes for backing up projects:

Project properties are stored in files or folders with filenames or folder names that are prefixed with a "'

(dot), for example ‘. project’. It is necessary to include these files or folders when archiving the project

for backup purposes.

In order to restore properties shared among projects, for instance when one project makes reference

to another project's files, please backup the whole workspace folder.
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3.2.2 Project Generation for RZ groups (RZ/A1, RZ/T)
This chapter illustrates an example when using the RZ/A1H Renesas Starter Kit.

The created project runs within the large-capacity internal RAM of the RZ/A1. When executing with flash
memory, change the program according to the specifications of the serial flash memory and memory placement.

RZ/T project generation is almost same with RZ/A1H.

For RZ/G, e? studio supports RZ Linux C/C++ project for developing Linux application. The Support for
RZ/G option has to be selected during e? studio installation. Refer to Figure 2-2.

To create a new project, invoke e? studio IDE from the Windows Start menu and specify a workspace directory.

Click File > New > C/C++ Project to open the new project creation wizard.

File Edit Source Refactor Mavigate Search  Project Renesas Views Run Window Help
l New | Al+Shift+M > [T RZ Linux C/C++ project
Open File... [t Makefile Project with Existing Code
4 Open Projects from File System... [@ C/C++ Project ]
— X
Close Ctrl+w | 4 Project...

Figure 3-27. Open New Project Creation Wizard

2. Select template for the new project (for example, Renesas RZ: ‘GCC for Renesas RZ C/C++ Executable
Project’). Click Next to proceed.

Templates for New C/C++ Project

All GCC for Renesas RZ C/C++ Executable Project

Make ez~ A C/C++ Executable Project for Renesas RZ using the GCC ARM
Renesas Debug Embedded toolchain.

Renesas RL/8

Renesas RX GCC for Renesas RZ C/C++ Library Project

FE="" A C/C++ Library Project for Renesas RZ using the GCC ARM

Embedded toolchain.
Renesas Synergy

@ < Back Finish Cancel

Figure 3-28. Select Project Template
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3. Enter the project name. Click Next to proceed.

New GCC for Renesas RZ Executable Project

New GCC for Renesas RZ Executable Project

Project name | Tutorial l

Use default location

default

Working sets

[1Add project to working sets

@ < Back

C:\Renesas\Workspace\v2020_04\Tutorial

Create Directory for Project

Browse...

New...

Select...

Finish Cancel

Figure 3-29. Specify Project Name

Select the following settings.

For example using the RZ/A1H Renesas Starter Kit:

* Language: ‘C’

+ Toolchain: ‘GCC ARM Embedded’
» Toolchain Version: ‘4.9.20150529’
» Target Device: ‘R7S7210071’

Select Create Hardware Debug Configuration and then J-Link ARM. Click Next to proceed.

New GCC for Renesas RZ Executable Project

Select toolchain, device & debug settings

Toolchain Settings

Language: ®c Oc++

Toolchain: GNU ARM Embedded ~

Toolchain Version{ 4.9.3.20150529 b4
Manage Toolchains...

RTOS: None ~

RTOS Version:

Device Settings

Target Device:[R?S?21001 ]

Unlock Devices...

Endian: Little b

Project Type: Default

Configurations
Create Hardware Debug Configuration
J-Link ARM ~

[ Create Release Configuration

@ < Back [ Next >

] | Finish | Cancel

Figure 3-30. Select toolchain, device & debug settings: e.g. RZ/A1H Renesas Starter Kit
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4. The Coding Assistant feature can be selected if required.

Note:
» The Peripheral Code Generator (CG) supports the generation of driver and peripheral function code
based on GUI settings. Functions are provided as APIs and are not limited to peripheral initialization.

»  Smart Configurator supports a single user interface that combines the functionalities of Code Generator
and Middleware Configurator. Smart Configurator encompasses a unified clock configuration view, an
interrupt configuration view and a pin configuration view.

5. Peripheral Code Generator and Smart Configurator may not be available for some devices.

6. Click Next to proceed.

New GCC for Renesas RZ Executable Project

Select Coding Assistant Settings

Use Smart Configurator :

Use Peripheral Code Generator
The e2 studio peripheral code generator and smart configurator automatically generates programs (device
drivers) for MCU peripheral functions (clocks, timers, serial interfaces, A/D converters, DMA controllers, etc)
based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APls) and are not limited to initialization of peripheral functions.

Automatic i

UART T qeneration ‘Application under

csl mer of peripheral development

AID function — | Software

oA | Pt settings Middleware

¥ Device - 1

DMA | Clack diver || RTOS |

_ Py - Microcontroller

@ < Back Finish Cancel

Figure 3-31. Select Coding Assistant Settings

7. Keep the default settings for additional CPU options and click Next to proceed.

New GCC for Renesas RZ Executable Project

bl dedAdditional CPU Options

Select Additional CPU Options

Instruction Set Arm
Inter Working
Target FPU vfpv3-d16 »

Floating Point ABI Hard ~

Warn if stack size exceeds the limit (H) | 100

@ < Back Next > Cancel

Figure 3-32. Select Additional CPU Options
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8. If the selected compiler was not updated by Libgen Update for GNU ARM Embedded Toolchains, a
warning message about the Library Generator will be shown in the next dialog box. Without the Library
Generator, there may be project build errors during compilation.

Refer to chapter 2.2.2 and run Libgen Update for GNU ARM Embedded Toolchains.
New GCC for Renesas RZ Executable Project =
Library Generator is not installed for the selected toolchain!
Select Library Source:
Optimized Newlib
Use this for further code size optimization.
Select Library Type:
Project-Built Pre-Built
Build the library with user specified options
‘/?: < Back Next > ‘ | Finish | Cancel
Figure 3-33. Library Generator Settings Warning Message
9. A project summary is displayed. Click Finish to generate the project.
New GCC for Renesas RZ Executable Project ==
Summary of project "Tutorial"
Device: R7S721001
Toolchain Version: 7.3.1.20180622
Files added:
generate/start.5
generate/inthandler.c
generate/interrupt_handlers.h
generate/typedefine.h
generate/vects.c
generate/hwsetup.c
generate/iodefine.h
generate/linker_script.Id
generate/iodefines/
Figure 3-34. New Project Creation Wizard (Summary)
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10. A new C project named ‘Tutorial’ will be created.

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
% Debug [ Tutorial HardwareDebu Hulh 4 | ® v & v &£ New Connection... MIERE R S-ER S o H
G E TG i A i®E S v TR R AR AR |Quick Access| || & ||Bc/Ce+ # Debug
‘1 Project Explorer & B%|® =5 RTyorialc % ° 0 %0 = Iz -0
| == Tutorial 3 ® /% PROJECT NAME : Tutorial A PEENY o ¥ T
& Includes 1e #include <typedefine.h> a4 typedefine.h
« &8 generate E #include <iodefine.h> o iodefineh
= iodefines 13 A _main() : void
@ hwsetup.c 14 e main(void) : int
[# interrupt_handlers.h 15 - #ifd?f CPPAPP
inthandler.c 16 //Iru‘t:lal:.lze glof_)al constructors
L 17 ~extern void _ main()
[ iodefine.h
18 {
[5 start.S 19 static int initialized;
[ typedefine.h 20 if (! initialized) =
8 vects.c 21 { . ¥ (o
Bl linker_scriptId 22 typedef void (*pfunc) (); v
< >
v & src
Tutorial.c 2 Problems B Console @ [l Properties @ Smart Bro... [ Stack Anal.. 2 Peripheral ... 23 Device Top... i Code Prev.. + Search O Memory ~ ©
= Tutorial HardwareDebug.launch OB EET& My
CDT Build Console [Tutorial]
< >

Figure 3-35. New C Project Created

This project consists of an application file Tutorial.c and a set of automatically generated files. All these
project and source files are listed in the Project Explorer panel reflecting the folder structure of the project, just
as seen in the standard file explorer.

Notes for backing up projects:

e Project properties are stored in files or folders with filenames or folder names that are prefixed with a "'
(dot), for example ‘. project’. It is necessary to include these files or folders when archiving the project
for backup purposes.

¢ In order to restore properties shared among projects, for instance when one project makes reference
to another project's files, please backup the whole workspace folder.
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4. Build

This chapter describes the build configurations and key build features of the e? studio IDE.

4.1 Build Option Settings

A new project generated with default options should run well, but it is possible to change build options with the
following configuration dialogs.

1. Right click on project ‘Tutorial’ and select Properties or use shortcut keys Alt + Enter to open the Properties
window.

The Properties window is supported at the workspace, project and source level. The Properties window for
project supports more configurations which apply across all the files within the same project workspace.

File Edit Source Refactor Navi &2 Import..

4 Debug <5 Export...

i3 v vt v vie Build Project

Clean Project
Refresh F5
Close Project

&5 Project Explorer &
la"TutoriaI [HardwareDehug_j] '

Close Unrelated Project

Build Targets >
Index >
Build Configurations >
© Run As >
4 Debug As >
Profile As >
Teamn Open Properties Dialog l
Compare With >

Restore from Local History...
MISRA-C >
Save build settings report

Change Device
@ C/C++ Project Settings Ctrl+Alt+P
# Run C/C++ Code Analysis
& System Explorer

El & a
Console & Command Prompt
No consoles to display at this tim Validate

Configure >
Source >
[ Properties Alt+Enter

-~ o~

Figure 4-1. Opening the Properties Window
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2. Click C/C++ Build > Settings > Toolchain to view or change the toolchain version.

type filter text

Resource
Builders
v Buid)

Build Variables
Environment
Logging
Tool Chain Editor

C/C++ General

MCU

Project References

Renesas QF

Task Repository

@

Run/Debug Settings

Settings

Configuration: HardwareDebug [ Active ]

® Tool Settings| ¥ Toolchain |® Device # Build Steps “ Build Artifact @ Binary Parsers @ Error Parsers

Current Toolchain

Toolchain: GCC ARM Embedded

Version: 4.9.3.20150529

Change Toolchain

Toolchain: GCC ARM Embedded ™
Version: |4.9.3.20150529 >

Additional Tools

Create Library generator
Create Flash image

~ | Manage Configurations...

Apply and Close

Cancel

Figure 4-2. Change Toolchain Version

3. Click C/C++ Build > Environment to select the current build configuration and add or edit environment

variables.

type filter text
Resource
Builders
v C/C++ Build
Build Variables

Environment

Environment

Conﬁguration:[ HardwareDebug [ Active | ]

~ | Manage Configurations...

Logging Environment variables to set Add...
Settings Variable Value Origin Select
Tool Chain Editor i AMS_KEEP_FILE ${synergyKeepFile} USER: PREFS
C/C++ General AMS_LICENSE_PATH ${synergylicenseFile} USER: PREFS Edit...
MCU CWD C\Renesas\Workspace\e2_v700\Tutorial\HardwareDebug BUILD SYSTEM Delete
Project References GCC_VERSION 493 BUILD SYSTEM Undefine
Renesas QE PATH C\Program Files (x86)\GNU Tools ARM Embedded\4.9 2015¢g3\... BUILD SYSTEM
Run/Debug Settings PWD C\Renesas\Workspace\e2_v700\Tutorial\HardwareDebug BUILD SYSTEM
Task Repository TCINSTALL C\Program Files (x86)\GNU Tools ARM Embedded\4.9 20153\  BUILD SYSTEM
TC_VERSION 4.9.3.20150529 BUILD SYSTEM
(® Append variables to native environment
(O Replace native environment with specified one
Restore Defaults Apply
@ Apply and Close Cancel
Figure 4-3. Build Settings for Compiler: Environment
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4. The build option allows user to retain all the toolchain configuration settings, including the path name
specified by the environment variables. The current build configuration is HardwareDebug, as shown in
Figure 4-3.

Build option details are described in the compiler user manual which is stored at {Compiler installation
directory}\share\doc. For example, it can be found in C:\Program Files (x86)\GNU Tools ARM
Embedded\4.9 2015g3\share\doc.

Note: As seen above, there is a Tool Chain Editor setting under C/C++ Build, but please do not change the
configuration in this option. The Tool Chain Editor is used for toolchains which are NOT supported by Renesas
build support plugins.

4.2 Building the Sample Project
A project can be built by one of the ways below:

Right click on the project and select Build Project

Click on the project to set focus and select Project > Build Project
Click on the project to set focus and click on the % icon

Click on the project to set focus and press Ctrl + B

poON =

File Edit Source Refactor Nav ¥ pglete Delete Help

* Debug Source > |+ |

- - = 4 A d | = Move...

-

&5 Project Explorer & Rename... F2

| Tutorial [HardwareDebuc| &1 Import.. 0JECT

1 Export... typed
iodef

[ Build Project

Clean Proje - -
Incremental Build of Selected Projects
Refresh =
_ APP
Close Project ze gl
Close Unrelated Project d _m
Build Targets > EFE
Index > Atial
Build Configurations >
def v
© Run As > rn pf
4 Debug As > rn pf
Profile As > € *Ps
Team > laliz
Compare With > (p =
Restore from Local History... OF

Figure 4-4. Building the Sample ‘Tutorial’ Project

5. The Console pane shows a Build Finished message to indicate a successful build. At the end of this
build, files output to the ${CWD} directory consists of makefile, Tutorial.elf, Tutorial.map,
Tutorial.hex, etc.
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6. Tutorial.elf isthe standard load module in ELF/DWARF format used for debugging.

& Console = £ £ 3 ==
CoBlEH R ME Yy
CDT Build Console [Tutorial]

~
'Building target: Tutorial.elf®

'Invoking: Cross ARM C Linker'
arm-none-eabi-gcc -mcpu=cortex-a9 -march=armv7-a -marm -mthumb-interwork -mlittle-endian -mfloat-abi=hard -mfpu=vfpv3-
'Finished building target: Tutorial.elf'

'Invoking: Cross ARM GNU Create Flash Image'
arm-none-eabi-objcopy -0 ihex "Tutorial.elf" "Tutorial.hex"
'Invoking: Cross ARM GNU Print Size'
arm-none-eabi-size --format=berkeley "Tutorial.elf"

text data bss dec hex filename

13164 32 e 13196 338c Tutorial.elf
'Finished building: Tutorial.siz'
'Finished building: Tutorial.hex'

16:28:39 Build Finished. @ errors, @ warnings. (took 6s5.693ms)

Figure 4-5. Project Has Built Successfully

4.3 Exporting Build Configuration Settings

The Project Reporter feature can export project and build configuration settings from the e? studio IDE to a file
for easy checking and comparison of project/build environment settings.

1. Right-click in the Project Explorer pane to bring up the context menu
2. Select Save build settings report to save the build settings report

File Edit Source Refactor Navi =2 Import..

# Debug & Export..

D v vt v vl Build Project
. Clean Project
& Project Explorer &
Refresh F5

v = Tutorial [HardwareDebug] Close Project

& Includes
Close Unrelated Project
£ generate
& src Build Targets >
> HardwareDebug Index >
E custom.bat Build Configurations > |
E Description.td O Run As N
B Tutorial HardwareDebug 4 Debug As N
B Tutorial HardwareDebug. Profile As >
El Tutorial Release.launch
Team >
Compare With >l
Restore from Local History... :
MISRA-C > |
[ Save build settings report ]

Change Device
¥ C/C++ Project Settings Ctrl+Alt+P
# Run C/C++ Code Analysis

Figure 4-6. Project Reporter
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5. Debug

This chapter describes the operation of the debug configuration and key debugging features of e studio. The
following illustration refers to ‘“Tutorial’ project built (in Chapter 4.2) and is based on the hardware configuration
of a Segger J-Link emulator and an RSK RZ/A1H board.

To open the specific perspective used for debugging, open ‘Tutorial’ project workspace in e? studio IDE and
select the Debug perspective.

® | R 2

Figure 5-1. Switch to Debug Perspective

A perspective defines the layout of views (related to development tools) on the Workbench. Each perspective
consists of a combination of views, menus and toolbars that enable user to perform a specific task.

For instance, the C/C++ perspective has views that help user to develop C/C++ programs and the Debug
perspective has views that enable user to debug the program. If you attempt to connect to the debugger in the
C/C++ perspective, then the IDE will then prompt you to switch to the Debug perspective.

One or more perspectives can exist in a single Workbench window. Each perspective can be customized, and
new ones can be added.

Note: For more information on debug, please refer to ‘e? studio Debug Help’ as described in chapter 6.
5.1 Change Existing Debug Configurations

The debug configuration has to be configured when debugging for the first time and only needs to be done once.
An existing debug configuration can be changed as follows.
1. Click the ‘Tutorial’ Project in the Project Explorer pane to set the focus.

2. Click Run = Debug Configurations... or ¥~ icon (downward arrow) - Debug Configurations...
to open the Debug Configurations window.

File Edit Source Refactor Navigate Search Project Renesas Views Window Help
# Debug & Tutorial HardwareDebu :#i @ Run Ctrl+F11 By o i we i
_ ) 3 . ) &,
@rveavievevyDavie s vl dBE T 8 v il Debug Pl B C/Ces |45 Debug
& Project Explorer iz = (no launch history) U RLEEED 7 lutline e
(¥ > R
& Tutorial [Hardware Debug As > l/* Eun 25 . Hl% W o % &
#inclut un Configurations... i ine.
Debug Configurations... ] #inclut jtypec.leflne h
p— - Debug History > ¥ ijodefineh
rganize Favorites... ” o
T3 4% Debug As > ' _main() : void
14 l Debug Configurations... l P main(void) : int
15 -#ifdef
16 //Init: Breakpoint Types >
< Toggle Breakpoint Ctrl+Shift+B
B Console = 11:ogg:e tlf.ni E:ea!q]tomt vy w =0
. . oggle Watchpoin
N les to display at th
O consoles 20 Aspray & Tis Toggle Method Breakpoint
' Skip All Breakpoints
Remove All Breakpoints
@ External Tools >
Figure 5-2. Open Debug Configurations Window
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3. In the Debug Configurations window, go to Renesas GDB Hardware Debugging - Tutorial
HardwareDebug. Click on the Main tab to ensure the load module is Tutorial.elf.

Create, manage, and run configurations < f&?
EX|E® Y Mame:| Tutorial HardwareDebug |
| # Debugger| # Startup % Source| = Common
[£] C/C++ Remote Application ~ ]
£ EASE Saript Ligeit
GDB Hardware Debugging | Tutorial Browse...
GDB OpenOCD Debugging C/C++ Application:
[£7 GDB Simulator Debugging (RH85( [ HardwareDebug/Tutorial.elf ]
Java Applet
Java Application Variables... Search Project... Browse...
& Launch Group Build (if required) before launching
# Launch Group (Deprecated) Build Configuration: Select Automatically £
[t Remaote Application
% Remote Debugger (O Enable auto build (O Disable auto build
Remote Java Application (® Use workspace settings Configure Workspace Settings...
~ [c] Renesas GDB Hardware Debuggin:
I (7 Tutorial HardwareDebug'
[ Renesas Linux Application
7 Renesas Simulator Debugging (RX
I8 Target Communication Framework v
< >
Filter matched 18 of 20 items s Apply
@ Close

Figure 5-3. Select Load Module

4. Switch to the Debugger tab, set ‘J-Link ARM’ as the debug hardware and ‘R7S721001’ as the target device.

Main & Debuggerl ¥ Startup | & Source| & Common

Debug hardware:lJ—Link ARM Iv Target Device:| R7S721001

GDB Settings Connection Settings Debug Tool Settings

GDB Connection Settings

(® Autostart local GDB server Host name or IP address: localhost

O Connect to remote GDB server GDB port number: 61224

Figure 5-4. Select Target Device
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5. Under the Debugger tab, go to the Connection Settings sub tab to configure the following based on the

settings in Segger J-Link emulator and RSK RZ/A1H board:

* Interface
- Type = ‘SWD’
- Speed = ‘Auto’

Note: The debug configuration shown in Figure 5-5 is an example. Incorrect settings may cause malfunction or
damage to the hardware. So please verify the board and emulator settings carefully before connection.

Create, manage, and run configurations

= =k
type filter text
€] C/C++ Application
€] C/C++ Remote Application
=/ EASE Script
[£1 GDB Hardware Debugging
[£1 GDB OpenOCD Debugging
GDB Simulator Debugging (RH850)
Java Applet
Java Application
& Launch Group
# Launch Group (Deprecated)
& Remote Application
%5 Remote Debugger
Remote Java Application
v [7 Renesas GDB Hardware Debugging
[ Tutorial HardwareDebug
Renesas Linux Application

[S Target Communication Framework

<
Filter matched 18 of 21 items

~
@

Renesas Simulator Debugging (RX, RL

>
Revert Apply
Close

Name: | Tutorial HardwareDebug
B Main ¥ Startup | Common | % Source

Debug hardware: |J-Link ARM

b3

Target Device: | R7/5721001

GDB Settingslconnec'tion Settings] Debug Tool Settings

v J-Link A
Type USB v
J-Link Serial {(Auto)
Settings File ${workspace_loc\${ProjName}\${Lau ...
Script File |
Low Power Handling No v

v Interface
Type SWD v
Speed (kHz) Auto v

v JTAG Scan Chain
Multiple Devices No v
IRPre 0
DRPre 0

v Connection
Register initialization No v
Reset on connection No v
Reset before run No v

ID Code (Bytes)

FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFE

-

Figure 5-5. Change Connection Settings
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6. Switch to the Debug Tool Settings sub tab, based on the RSK RZ/A1H board to ensure:

e Memory
Endian = ‘Little Endian’

Create, manage, and run configurations

R IEE R
type filter text

% GDB Simulator Debugging (RH850 A
Java Applet
Java Application

& Launch Group

# Launch Group (Deprecated)

& Remote Application

4 Remote Debugger
Remote Java Application

v [5 Renesas GDB Hardware Debugging

&1 Tutorial HardwareDebug

% Renesas Linux Application

7 Renesas Simulator Debugging (RX,

8 Target Communication Framework "

< >
Filter matched 18 of 21 items

@

B
Name: | Tutorial HardwareDebug |
B I\.;‘1ain|iii Debugger l ¥ Startup| £ Common| % Source
Debug hardware: |J-Link ARM ~ | Target Device: R75721001
GDB Settings Connection Settings éDebug Tool Settings§
N (0] ~
Use Default 10 Filename Yes v
10 Filename ${eclipse_home}
v General Debug
Reset After Reload Yes v
v Memory
I Endian Little Endian l v
v Break
llse Flash Breaknoints No v Vv
Revert Apply
Close

Figure 5-6. Change Debug Tool Settings

Click the Apply button to confirm the settings. Then click Debug to execute the debug launch configuration
to connect to the Segger J-Link and RSK RZ/A1H board.

After the successful connection, select the Debug view to show target debugging information in a tree
hierarchy. The program entry point is set to the function _PowerON_Reset() infile start.s.

%% Debug ©

& ¢ n

~ [ Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
v i Tutorial.elf [1]
v o Thread #1 1 (single core) (Suspended : Signal : SIGTRAP:Trace/breakpoint trap)

[ = _PowerON Reset) at start.5:51 0x20020114 |

#5 arm-none-eabi-gdb (7.8.2)

#! Renesas GDB server (Host)

Figure 5-7. User Target Connection in the Debug View
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5.2 Create New Debug Configurations

The simplest way to create a new debug configuration is by duplicating an existing one. It can be performed by
the following steps.

1. Repeat step 1 in chapter 5.1 to open the Debug Configurations window.

2. Select a debug configuration (e.g. ‘Tutorial HardwareDebug’) and then click the icon (this duplicates the
currently selected launch configuration). A new debug launch configuration (e.g. ‘Tutorial HardwareDebug
(1)") is created. It can be renamed to identify the settings by typing in the Name textbox and then clicking the
Apply button.

Create, manage, and run configurations
Lllsea Mame:ll Tutorial HardwareDebug 4k l |
type filter text El Main % Debugger . ¥ Startup| &~ Source| & Common
€1 C/C++ Application
[© C/C++ Remote Application Debug hardware: | J-Link ARM ~ | Target Device: R75721001
= EASE Script
[= GDB Hardware Debugging GDB Settings Connection Settings Debug Tool Settings
GDB OpenOCD Debugging v J-Link ~
& GDB Simulator Debugging (RH850) Type USB i
Java Applet J-Link Serial {Auto)
Java Application Settings File ${workspace_loc\${ProjNamel\${lau ...
% Launch Group Script File
# Launch Group (Deprecated) Low Power Handling No v
B Remote Application v Interface
# Remote Debugger Type JTAG v
Remote Java Application (_speed (kHz) 4000 | v
v [ Renesas GDB Hardware Debugging v JTAG Scan Chain
&1 Tutorial HardwareDebug Multiple Devices No v
[EI Tutorial HardwareDebug 4k] IRPre 0
% Renesas Linux Application DRPre 0
[ Renesas Simulator Debugging (RX, RL v Connection
i Target Communication Framework Register initialization No v
Reset on connection No v
Reset before run No v
ID Code (Bytes) FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFR v
£ >
Filter matched 19 of 22 items Reyert

Figure 5-8. Duplicate A Selected Debug Launch Configuration

3. The debug configuration can be configured as described in chapter 5.1. For example, change the interface
speed to ‘4000'.
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4. The launch configuration is marked with ‘[local] and a “*’ marker indicating that it is not yet attached to any
project. Please specify project name in the Common tab.

Create, manage, and run configurations

RIICE Name:|Tutoria| HardwareDebug ‘

t filter text - .
ype Titer tex El Main |% Debugger ¥ Startup B Source
~

Remote Java Application

Save as

+ [c] Renesas GDB Hardware Debuggin .
. O Local file
&% * Tutorial HardwareDebug [local]

[ Renesas Linux Application [©§Shared file: ] ‘ \Tutorial Browse...
7 Renesas Simulator Debugging (RX, RL7¢ Display in favorites menu Tl
B Target Communication Framework v || M4 nahun | (® Default - inherited (UTF-8) v
< >
Revert Apply

Filter matched 18 of 21 items

Figure 5-9. Attach Launch Configuration to a Specific Project
5.3 Launch Bar

This chapter explains the usage of the Launch Bar, which is supported from V6.0.0 or later.
The Launch Bar is located in the toolbar area of e? studio’s main window.
This simple interface includes build and debug buttons for the selected launch target.

File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

@ || % || ®| |45 Debug X | |E2] myprj Hardwa{[.‘lebug ] |
Buttons to perform build/launch debug for selected target Select build/debug target

Figure 5-10. The Launch Bar Interface

The Launch Bar buttons behave as follows:
e The build button | &, | builds the load module of the selected launch configuration.

Note: There is another build button % ~ in the project management toolbar which builds the active

build configuration in Project Explorer. Note that the launch bar does not reflect the active build state
of Project Explorer, so care must be taken to ensure that you’re not building one configuration, and
then launching another.

e Thedebug | F | button triggers the launch of the debugger.

e The stop button terminates the selected launch target.

The Launch Bar and build button can be hidden through the following dialog.

e Click Window menu - Preferences, then click Run/Debug > Launching - Launch Bar
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54 Basic Debugging Features
This chapter explains the debug views supported by the e? studio IDE.

e Standard GDB Debug (supported by Eclipse IDE framework): breakpoints, expressions, registers, memory,
disassembly and variables

¢ Renesas Extension to Standard GDB Debug: eventpoints, I/O registers and trace.

The following are some useful buttons which exist in the Debug view:

Disconnect Step Into (F5) Step Over (F6)
File Edit—souree L= T o] S K s 1o = Froject menesas Views  Run Window  Help

NROES

|| & New Connectigh...

[£7] Tuterial HardwareDebug Y- | & - @

BRI aI®® i A0 Gl METREE A T

Terminate

Suspend

Resume (F8) Download Reset Restart

Figure 5-11. Useful Toolbars in Debug Views
The program is run by clicking the button or by pressing F8.

The program can be paused on a breakpoint or by clicking the button. When the program is paused,
you can perform the following operations:

e The . button or F5 can be used for stepping into the next method call at the currently executing line
of code.

e The ‘=% button or F6 can be used for stepping over the next method call (executing but without entering
it) at the currently executing line of code.

e The [I= button can be clicked again to resume running.

The [B button can be clicked to end the selected debug session and/or process, and the 4 button can be
clicked to disconnect the debugger from the selected process.

Some other operations are as following:
e The .;35.:., utton can be clicked to start new debug session.
e The T-E;. button can be clicked to reset the program to the power-on-reset entry point.

e The U button is used for re-downloading the binary file to the target system.
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Note: To demonstate the features in following section, please use the sample code for the RZ/A1H from the
Renesas website as follows:

1.

Download the Starter Kit Sample Code for RZ/A1H from the Renesas website:
https://www.renesas.com/sg/en/software/D6000665.html.

Follow the instructions in chapter 3.1 to import the project “RZ_A1H_Tutorial_RSK” to the workspace.

Open the project properties, select C/C++ Build - Settings in the left pane. Select tab Toolchain and
select the GNU ARM Embedded toolchain for the project. Click Apply and Close.

type filter text
Resource
Builders
Build Variables
Environment
Logging
Tool Chain Editc
C/C++ General
MCU
Project References
Renesas QE
Run/Debug Settin
Task Repository

@

Settings

Configuration: HardwareDebug [ Active ]

® Tool Settings (¥ Toolchain J® Device # Build Steps

Current Toolchain
Toolchain: KPIT GNUARM-NONE-EABI Toolchain

Version: wv14.02

Change Toolchain
N
Toolchain[GCC ARM Embedded >

Version: (14.9.3.20150529 v

Additional Tools
Create Library generator
Create Flash image

~ | Manage Configurations...

Build Artifact & Binary Parsers @ Error Parsers

Apply and Close

Cancel

Figure 5-12. Update Project Toolchain
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4. Right click on the project name in Project Explorer, select Change Device to select the correct device.

Eile Edit Source Refactor Navigate Search B Copy

4 Debug v||FIRZ ATH.T N Paste

Delete
| Source
& Project Explorer & B % Move...
v [1.::‘ RZ_A1H Tutorial RSK [HardwareDebud: Rename...
" Binar
#. blnaries © e
&l Includes !
5 Export...
= compiler_specific
& doc Build Project
= HardwareDebug Clean Project
& inc 21 Refresh
= src Close Project
B custom.bat Close Unrelated Project

LoadTutorialToQSPl.bat

LoadTutorialToQSPIDebug.Command

LoadTuterialToQSPIRelease.Command

makefile.init

RZ_A1H_Tutorial_RSK HardwareDebug.| © Run As

RZ_A1H_Tutorial_RSK Release.launch # Debug As
Profile As

[

Build Targets

[

Index

I

Build Configurations

M m

[

Team
Compare With
Restore from Local History...
MISRA-C
Save build settings report
[ Change Device ]
C/C++ Project Settings
Run C/C++ Code Analysis

Command Prompt
Validate

KB ® % %

Ctrl+C
Ctrl+V
Delete

F2

F5

Ctrl+Alt+P

System Explorer

Change Device

Select the new device for RZ_A1TH_Tutorial RSK

Current: R7572100

Target Device:| R75721001

@ < Back lI Next > ] Einish

Unlock Devices...

Cancel

Figure 5-13. Change Device
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5. After selecting the new device, click Next — Next to review changed information for the new device. If
everything is OK, click Finish.

Change Device =2
Review the information provided in the list below. Click 'Next >' to view the next item .
or 'Finish'.

Found problems \ahij

% Unable to load project generation settings for Release. Some build settings may not be set cc

#Unable to load project generation settings for HardwareDebug. Some build settings may not

% This change cannot be undone. Please make sure you backup this project before continuing.

< >

No context information available

@ < Back Einish Cancel

Change Device ==

The following changes are necessary to perform the refactoring.

Changes to be performed
~ [v] & Build Settings N
& Release
& HardwareDebug
v [V] & Project Files
[v]& generate/start.S
[v]& generate/inthandler.c
[v]& generate/interrupt_handlers.h
[v]& generate/typedefine.h
[v]& generate/vects.c
[v]& generate/vect table.S
[v]& generate/hwsetup.c

| ) IS S U DY - v
15l Assembly Compare Viewer DM 4 4 435
New Resource /RZ_A1H Tut..le.S" does not exist.
L/ R KA KK KK K K K KK KKK K F K 1

2/% File Version: Vl1.ee
3/* Date Generated: 19/64/20

4/*****************************

@ < Back Next > Cancel

Figure 5-14. Changed Information after Changing Device
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6.

Switch to the Tool Settings tab, select Cross ARM C Linker - General, and add the script file generated
by the compiler to the script file list. Click Apply and Close.

Settings

% Tool Settings | ® Toolchain ® Device # Build Steps

Configuration: HardwareDebug [ Active ]

Build Artifact i Binary Parsers @ Error Parsers

(% Target Processor
& Optimization

2 Warnings

% Debugging

v @ Cross ARM GNU Assembler

(2 Preprocessor

Script files (-T)

"${ProjDirPath}/src/linker_scriptHardwareDebug.ld"

Manage Configurations...

B

2 Includes

& Warnings

@) Add file path

# Miscellaneous File:

v & Cross ARM C Compile|

l B{workspace_loc:/.‘p{ProjName}/compiler_specific/GNU_I RAM.Id} l

(& Preprocessor
2 Includes
(# Optimization
& Warnings
(2 Miscellaneous
~ ® Cross ARM C Linker

Cance

Workspace...

File system...

2 Libraries

& Miscellaneous
& Other

v & Cross ARM GNU Create Flash Image

2 General

v & Cross ARM GNU Print Size

2 General

Entry Point: |

[ ]Use custom linkage order
linkage Crder List

"\src\ascii.o"
"\src\bsc.0"

"\src\bsc_userdef.o"
"\ A flachlad A%

e

a8 a5 #

Apply and Close

Cancel |

7.

Figure 5-15. Add Compiler Generated Script File

Build the project and make sure that it is successful.
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5.4.1 Breakpoints View

The Breakpoints view stores the breakpoints that were set on executable lines of the program. If a breakpoint
is enabled during debugging, the execution suspends before that line of code executes. e? studio allows
software and hardware breakpoints to be set explicitly in the IDE. Any breakpoints added via double click on
the marker bar are by default hardware breakpoints. If the hardware resources are not available, then the
breakpoint setting will fail. In case of a hardware breakpoint setting failure, an error message will prompt you to
switch to a software breakpoint.

To set the default breakpoint type (hardware or software):

1. Right-click on the marker bar to bring up the context menu. For a hardware breakpoint, select Breakpoint
Types > e? studio Breakpoint. For a software breakpoint, select Breakpoint Types > C/C++
Breakpoints.

To set a breakpoint:

1. Openmain.c and double-click on the marker bar located in the left margin of the C/C++ Editor pane to set
a breakpoint. A dot ¥ (hardware breakpoint) or ## (software breakpoint) is displayed in the marker bar
depending on the Breakpoint Type selected. Breakpoint Type is hardware breakpoint by default.

2. Alternatively, right-click at the marker bar to choose Toggle Hardware Breakpoint or Toggle Software
Breakpoint to set a hardware breakpoint ¥ or a software breakpoint #&.

3. Click Windows > Show View - Breakpoints or the breakpoints icon ®e (or use shortcut key ALT + Shift
+ Q, B) to open the Breakpoints view to view the corresponding software breakpoints set. Software
breakpoints can be enabled and disabled in the Breakpoints view.

To disable breakpoints, you can choose to disable specific breakpoints or to skip all breakpoints:

1. Todisable a specific breakpoint, right-click on the software breakpoint or hardware breakpoint % located
in the left margin of the C/C++ Editor pane and select Disable Breakpoint, or uncheck the related line in
the breakpoints view. A disabled breakpoint is displayed as a white dot ( = or ).

2. To skip all breakpoints, click on the " icon in the breakpoints view. A blue dot with a backslash will appear
in the editor pane as well as in the breakpoints view.

File Edit Source Retactor Navigate Search Project Renesas Views Run Window Help
4 Debug E9RZ A1H Tutorial RSK = | ® v & v &2 New Connection. VMM B viRiN | BN R R
o v DB B A O EYyQrimmSo yvidivivooy o f%‘@CICH 4 Debug
‘= 4 Debug ® liv]& = =8 % Breakpoints I
e . RZ_A1TH_Tutorial_RSK HardwareDebug [Renesas GDB Hardware = RE IR EPES < g:
"‘:7 v @ RZ ATH Tutorial RSKx [1] [] @ main.c [line: 157] [type: Hardware] L
'] v o Thread #1 1 (single core) (Suspended : Breakpoint)
@ = main() at main.c:1
IS £ arm-none-eabi-gdb (7 L Breakpoints 5 =
o i Renesas GDB server (H .
iy x & ® | FE
0 | .0 main.c [line: 157] [type: Hardware]
i
0
?
< >
" Bmainc % [8 start.S o C
143 ®* Function Name: main[] ~

- 152 int_t main(void)

| 153 20042ae8 {

154 20@42af4 char strdata[32] = "";

| 155 20042b54 uint8_t * pmptr = &g_rgb888_logo[e];

Ié\ 20042060 | R_RIIC_rzalh_rsk_init();

/* Initialise SPI */
ka R_SPI_Init();

- /* Initialise the PMod Colour LCD display */
| 163 20042068 R_LCD_Init();

/* Tnitialisa diract connactad |ED */ b

Figure 5-16. Breakpoints view
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5.4.2 Expressions View

The Expressions view monitors the value of global variables, static variables or local variables during
debugging. For all RZ/A1H debuggers, these variables (including the local variables in scope) can be set for
real-time refresh.

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

4 Debug & RZ_ATH_Tutorial_RSK I Juihd | ® v & v &% New Connection... MR SR S -ER N A I A S
0 vt R H A E A AT N R S T R SR 2 |Quick Access|i| ® | B C/C++ % Debug
= % Debug = [#€ 7= 8 lwyarables % Breakpoints ! Registers ¥ Expressions ¥ e® Eventpoints % Peripherals (10 Registers ~ & =
;' ~ &1 RZ_A1H_Tutorial_RSK HardwareDebug [Renesas GDB Hardware HEe e R K[ riee < _g:
: ~ @ RZ_ATH_Tutorial RSKx [1] Expression Type Value Name : g_data_block_content &
vl - - - . — Details:@ '\8" b=l
o v o Thread #1 1 (single core) (Suspended : Breakpoint R g_data_block content  unsigned char 0\0 I Default:o ° :B'
@ = main() at main.c:157 0x20042b60 % Add new expression Decimal:e
g #i arm-none-eabi-gdb (7.8.2) Hex:@x@
o 12 Renesas GDB server (Host) Binary:@
R Octal:@
4
)
B
@
(0]
3
g < > < >
’ i led|pmod.c 2 = E
86 /* LCD cursor co-ordinates */ ~
87 uint8|t g_curx = @u;
88 uint8|t g_cury = @u;
89
98 /* sefl m_InverseMode to 1 to invert display */
91 uint8_[t g_inverse_mode = @u;
92
93 uint32|t g units = eéu;
94 uint32]t g cmd = @u;
95
96 uint8_t| g_data_block_contentl: eu;
97
98 uintlé_t g_font_colour = COL_BLACK;
99 uintlé_t g_back_colour = COL_WHITE;
100 e

Figure 5-17. Expressions View

To watch a global variable:

1. Click Window - Show View - Expressions or the icon Hto open the Expressions view

2. Drag and drop a global variable over to the Expressions view. Alternatively, right-click on the global
variable and select the Add Watch Expression... menu item to add it to the Expressions view.

3. In the Expressions view, right-click to select the Real-time Refresh menu item. This refreshes the
expression value in real-time when program is running. The character ‘R’ indicates that this global
variable will be updated in real-time.

4. To disable the real time refresh, simply right-click to select the Disable Real-time Refresh menu item.
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5.4.3 Registers View

The Registers view lists the information about the general registers of the target device. Changed values are
highlighted when the program stops.

“=Variables % Breakp... ‘% Registers ¥ % Express.. «®Eventp.. = Periphe.. illOReg.. =
SB[ ¥
Name Value Description ~
v I General Registers General Purpose and FPU Regi...
it rQ 0x0
o 0x22
12 0x0
0 r3 0x2000007e
siv! 14 0x0
W r5 0x0 M
Name : rl
Hex:@x22
Decimal:34
Octal:042

Binary:1eee1le
Float:4.76441478e-044
Default:34

Figure 5-18. Registers View
To view the general register r0’:

10
a1

1. Click Window > Show View > Registers or the ii:i icon to open the Registers view.

2. Click ‘rO’ to view the values in a different radix.

Values that have been changed are highlighted in yellow in the Registers view when the program stops.
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5.4.4 Memory View

The Memory view allows users to view and edit the memory presented in ‘memory monitors’. Each monitor
represents a section of memory specified by its base address. The memory data in each memory monitor can
be presented in different ‘memory renderings’, which are predefined data formats (e.g. hex integer, signed
integer, unsigned integer, ASCII, image, etc.)

To view the memory of a variable (e.g. g_data_block_content):

1. Click Window > Show View - Memory or the [0 icon to open the Memory view.

Click theiconto == open Monitor Memory dialog box. Enter the address of the variable
g data_block_content.

@ Monitor Memory X
Enter address or expression to monitor: The global variable g_data_block_content is
presented in memory renderings of ‘Hex Integer’
‘ &g_data_block_content ~ ‘ E
format.
@ oK Cancel
|BCo.. “Tas.. ! Pro.. @Fxe.. ®Sm.. BDe.. . BRe. ™Re. %®Ta. #Me. [0Me. CPer. OVis.. 2Re.. DMe. 2 #Se. O
g O |t G| % vy -
| Monitors x % &g data block content : 0x20057B84 <H£x Intqur & 50 New Renderinqs=
(¢_&g data block content Address e -3 4 -7 8 - B C-F -
0000020057880 ©coopopen ezl 000000Be ©OCOLORe

0000000020057B98 00CDOEOE 0©C0O0COEE CDO0BOBe 00000080
000000PO20057BAR ©00CDOOOE ©OODCOEE COPOOOEE ©OLOELEe

Memory Monitor for 0000000020057BBB ©£0E0EEEE 0POPEEER ObobLeEe BoBecese
“g_data_block_content" is 0600000026057BCE ©0C0OCOEE 0©OCOCEOEE OCOCOCEBe Cooecece
specified by the address 000e0e0e20057BD8 ©OCOEEEE ©DODEEEe Cooooeee cececeece
"&g_data_block_content" 0000000020057BEG@ 0©O0C0COEe ©OOBOERe O©COcoeeee oececeee

©000000PO20057BF@ 00CDCEEE ©C0DO0CEEE CDEEOOEE 0000e0Be
0000000020057C08 00CDOOOE 0©C0ODEOEE CDO0OOBE 00000080
0000000020057C18 00000000 0000B0EE B00000EBE 080800080 ™

Figure 5-19. Memory View (1/2)
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To add new renderings format (e.g. ASCII) for the variable g_data_block_content:

1. Click the & Mew Renderings...| tab and select ‘ASCII to add the rendering

This creates a new tab named ‘&g_data_block_content < ASCII> next to the tab
‘&g_data_block_content <Hex Integer>’.

0 Memory =

Monitors + X%

@ &g_data_block_content

| 0 Memory

| Monitors &= X%

81g_data_block_content <Hex Integer> [4}-‘ New Renderings.?‘\
|Mem0ry Monitor: &g_data_block_content : 0x20057884

Select rendering(s) to create:

Image A | Add Rendering(s)
Raw Image

Floating Point
Traditional

T

Signed Integer
Unsigned Integer

Gmowe o |5 @G By =0

&g_data_block_content <Hex Integer> [&gidataiblockicontent : 0x20057B84 <ASCII ZN New Renderings..}

@ &qg_data_block_content

Address e-34-7 8-BC-F ~
eeeoeeee26057B80
©oceeeve28057B90
©ocoeeve28057BAG
00000PPO20057BBO
000PPLPO28057BCO
000000PO28057BDO
00000CPO28057BER
eeeoeeee26057BFe
©ocoeeve28857C80
Poeeeeve28857C1e

E

EEEEEEEEEE

EEEEEBEEEEEBE
EEEEEBEEEBE
EEEEEEEEBE

Figure 5-20. Memory View (2/2)
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5.4.5 Disassembly View

The Disassembly view shows the loaded program as assembler instructions mixed with the source code for
comparison. The currently executing line is highlighted by an arrow marker in the view. In the Disassembly
view, user can set breakpoints on assembler instructions, enable or disable these breakpoints, step through the
assembler instructions and even jump to a specific instruction in the program.

[g main.c # [SstartS  [dled_pmod.c S =
134 20e42acsd __asm__("nop"); ~
135 }

136 2@e42adc ¥
137
139 @* End of function delay[]
141
143 @* Fynction Name: main[]
=int_t main(void)
20042ae8 {
2e042af4 char strdata[32] = "";
2ee42bs4 uint8_t * pmptr = &g_rgb888_logo[0];
20042b68 R_RIIC_rzalh_rsk_init(); ]
/* Initialise SPI */
20042b64 R_SPI_Init();
/* Initialise the PMod Colour LCD display */
20042b68 R_LCD_Init();|
/* Initialise direct connected LED */
20042b6c R_LED_Init();
/* Initialise board switches (SW1,SW2,SW3) */ This allows the assembly
26042070 init_switches(); source to be linked with the C v
source (active debug context).

= Olitline = Disassembly 2 1 Project Explorer [Enter location he « || | it == 0
20042b50: ©x043083e2 main+le4 add r3, r3, # 2
15 uint8_t * pmptr = &g_rgb888_logo[e];
2ep42b54: ©xf437@1e3 main+l1es movw r3, #6132 5 Ox17f4
20p42b58: ©x053042e3 main+1l2 movt r3, #8197 ; @x2ees
20942b5c: ©x10300be5 main+116 str r3, [rll, #-16]

w157 R_RIIC_rzalh_rsk_1init();

» 20042b66: ©x610de@Peb main+120 bl 0x200460ec <R_RIIC_rzalh_rsk_init>
160 R_SPI_Init();
20042b64: ©x5417@80eb main+124 bl ©x200488bc <R_SPI_Init>
163 R_LCD_Init();
20042b68: @x31faffeb main+128 bl 0x20041434 <R_LCD_Init>
166 R_LED_Init();
20042b6c: Oxleffffeb|main+132 . Ox200427ec <R_LED_Init>
169 Function Offsets it switches();
20042b70: main+136 b1 ©x200475d4 <init_switches>
172 display_image (pmptr, 128, 24, 8, 184);

20042 Opcodes 8e3 main+14e mov r3, #le4 ; Ox68 =
20042 de5 main+144 str r3, [sp]
20042b7c: ©x1eeolbe5 main+148 ldr re, [rll, #-16]
20042b80: ©x8€10a0e3 main+152 mov rl, #128 ; Ox8e
20042b84: ©x1820ale3 main+156 mov r2, #24
20042b88: ©x0e30a0e3 main+léee mov r3, #0
20042b8c: ©x93faffeb main+l64 bl 6x200415e@ <display_image>
173 display_on(); v
IABATIROA . BvIOLALLAlh matTni1E0 k1 BuARATAT A~ A cnT A Al

Figure 5-21. Disassembly View
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To view both C and assembly codes in a mixed mode:

1. Click Window -> Show View > Disassembly or the ==

2. Click the
debug context).

icon to open the Disassembly view.

q:b icon to enable synchronization between the assembly source and the C source (active

3. In the Disassembly view, right-click on the address column to select Show Opcodes and Show Function

Offsets.

4. You can enable and disable source addresses within the editor using the context menu.

Toggle Software Breakpoint
Toggle Hardware Breakpoint

Toggle Breakpoint

Add Breakpoint...

Add Dynamic Printf...

Enable Breakpoint

Breakpoint Properties...

Breakpoint Types

Switch Default e2 studio Breakpoint type to Software

Build Selected File(s)

Clean Selected File(s)

Toggle Timer Start Eventpoint
& Toggle Timer Stop Eventpoint

Edit Eventpoint

Disable Timer Stop Eventpoint

Disable Timer Start Eventpoint

Clear Coverage Markers

Toggle Relocated Breakpoint Enabled

Ctrl+Shift+B
Ctrl+Double Click

Shift+Double Click

Ctrl+Double Click

Ctrl+Alt+Shift+B
Ctrl+Alt+Shift+C

Delete Relocated Breakpoint & main.c % |2 led pmod.c =g
= Go to Disassembly ¢ End of £ o el ~
®* E t
Go to Annotation nd of function delayl]
U Toggle Monitor Point ®* Function Name: main[]
Enable/Disable Monitor Point “int_t main(void)
. . . 20042060 | {
% C/C++ Project Settings 20842b6¢ char strdata[32] = "";
Validate 20042b98 uint8_t * pmptr = &g_rgb888_logo[@];
Add Bookmark... 20042bad R_RIIC_rzalh_rsk_init();
Add Task... L.
/* Initialise SPI */
[\/ Show Source Addresses ] 20042ba8 R_SPI_Init();]
§ Show Eventpoints /* Initialise the PMod Colour LCD display */
v Show Quick Diff 20042bac R_LCD_Init();
- fommlmEomoEs /* Initialise direct connected LED */
Folding 20042bbe R_LED_Init();
v
Preferences... G =t : : — N
Figure 5-22. Source Addresses Menu
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5.4.6 Variables View
The Variables view displays all of the valid local variables in the current program scope.

Please refer to the Expressions View section to watch global variables or external variables out of the current
program scope.

- Variables & HE|cd(% Y=o
Name Type Value Name : sFrdaFa , .
> (® strdata char [32] 0x2090ffc4 g:::ﬂf:ja)\(gw;;iziats 31 times>
» pmptr unsigned char * 0x200517f4 <g_rg... Decima1;546373572
Hex:@x209effc4
Binary:1009@6160100601111111111000160
Octal:e4e441777e4
main.c & | 8 startS  [dlcd_pmod.c -0
@* Function Name: main[] A
int_t main(void)
20042ae8  {
20042af4 char BATEIRE32] = "";
20042b54 uint8_t * pmptr = &g_rgb888 logo[e];
20042b60 R_RIIC_rzalh_rsk_init();

/* Initialise SPI */
20042b64 R_SPI_Init();

/* Initialise the PMod Colour LCD display */ v

Figure 5-23. Variables View
To observe a local variable (e.g. strdata in function main()):

1. Click Window > Show View > Variables orthe = icon to open the Variables view.

2. Step into the function main() to view the value of local variable strdata.

Note:
Variables which are optimized out or temporarily allocated to accumulator registers may not appear in this view.
Please refer to the Disassembly view if necessary.
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5.4.7 Eventpoints View

An event refers to a combination of conditions set for executing break or trace features during program
execution. The Eventpoints view allows you to set up or view defined events from various categories e.g. trace
start, trace stop, trace record, event break, before PC, performance (timer) start and performance (timer) stop.

The number of events that can be set and the setting conditions differ with each MCU. There are two types of
event:

. Execution address: The emulator detects execution of the instruction at the specified address by the
CPU. It can be a ‘before PC’ (before Program Counter) break (the event condition is satisfied immediately
before execution of the instruction at the specified address) or other events (where the event condition is
satisfied immediately after execution of the instruction at the specified address).

. Data access: The emulator detects access under a specified condition to specified address or specified
address range. This allows the setup of complex address and data matching criteria.

Event combination (e.g. OR, AND (cumulative) and Sequential) can be applied to two or more events.

To set an event break for a global variable when a variable is accessed (e.g. when g_adc_result is assigned
a new value):

1. Click Window > Show View > Eventpoints or the ®® iconto open the Eventpoints view.
2. Double-click the Event Break option to open Edit Event Break dialog box.
3. Click the Add... button to continue.

€0 Edit Event Break X

Trigger: OR

Type Address Data Count Timer Handle Comment

Add.. || Edit..  Delete  PC:0/0 OA: 0/4 All: 0/4

OK Cancel

Figure 5-24. Edit Event Break

4. Select Data Access as the eventpoint type.

5. Go to the Address Settings tab, click the [.J icon and browse for the symbol g_adc_result (the
address of this global variable is & adc_result).
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6. Next, switch to the Data Access Settings tab, select ‘Write’' for Data Settings. Click OK to proceed.

aAdd Eventpoint X gAdd Eventpoint X
Eventpoint Type[ Data Access ] Eventpoint Type: Data Access
Address Settings JData Access Settings Address Settings [Data Access Settings ]
Address: lJ &g_adc_result v IE Data Settings:
Read/Write: »
Size: Not Specified ~
Bus Master: CPU
! Edit Event Break X
Trigger: OR
Type Address Data Count Timer Handle Comment
MAOR  &gadcresut  WiteAl |
< >
Add.. = Edit. | Delete pC: 0/0 OA: 1/4 All: 1/4
Cancel

Figure 5-25. Add Eventpoint

7. Ensure that the event break for &_adc_result is set and enabled in the Eventpoints view. Reset to
execute the program from the start.

3
%
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[1+]

n

=

[}
]

7
=)

o

;

I

=)
o
=}
I}
:
[
w

1

Expressions e® Eventpoints O Registers ==

%

% % % B B[ PC:0/6OA /4 | 2| 2

Type Address Data Count Timer Handle Comment

[ | Trace Start

[ ] & Trace Stop

[ ] ® Trace Record
v [v] ® Event Break

| OR &g_adc_result (0x20057b74)  Wite All 7 |

[ ]w Timer Start

[ Timer Stop

Project Saved Templates

g mainc  EstartS  [dled pmod.c  EinitsctS | [E adc.c ® |[€ flashled.c ==
~
* Bead the resylt resjster for ANT *
g _adc_result = ((uint32_t)ADC.ADDRH >> 4u); ]
/* Check if the upper and lower limits have been read */
if ((uint32_t)@u == g_adc_result)
g_adc_complete_flag |= ©x80u; v

Figure 5-26. Execution of Event Break

Figure 5-26 shows that when g_adc_result is assigned a new value, the program stops at code line number
303 of adc. c (where g_adc_result is assigned new value).
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5.4.8 10 Registers View

10 Registers is also known as the Special Function Registers (SFR). The 10 Register view displays all the
registers set defined in a target-specific I/O file, including their address, hexadecimal and binary values. You
can further customize your own 10 registers view by selectively adding I/O registers to the Selected Registers
pane.

= Variables % Breakpoints i Registers “f Expressions e® Eventpoints |IZ 10 Registers 5?3] -0

+—.‘3@¢_'1::|ﬂ|fv

Name Value (Hex)  Value (Bin) .. Address Access ~
MMC
MTU2
v OSTMO I
OSTMOCMP ] 0x00000000 000000000... OxfcfecOD0  RW
OSTMOC OxfiFfefee 111111111... Oxfcfec004  RW
OSTMOT 0x00 00000000 Oxfcfec010  RW
OSTMOT 0x00 00000000 Oxfcfec014  RW
OSTMO 0x00 00000000 Oxfcfec018  RW
OSTMOC 0x00 00000000 Oxfcfec020  RW
OSTM1
PFVO v

All Registers [Se d Registers

»=Variables “ Br oints Hi Registers %< Expressions ¢® Eventpoints [ 10 Registers

1TE2ds0=H = ~

= 0

Name Value (Hex)  Value (Bin) .. Address Access
¥ OSTMO
[0 OSTMOCMP  0x00000000  000000000... Oxfcfec000 RW ]

All Registers [Selected Registers |

Figure 5-27. 10 Registers View
To view selected I/O registers (e.g. OSTMOCMP in OSTMO):

1. Click Windows > Show View - Others... In the ‘Show View’ dialog, click IO Registers under Debug or
the ﬂ icon to open the 10 Registers view.

2. Under the All Registers tab, locate OSTMO in the 10 Registers view. Expand the OSTMO /O register list.

3. Drag and drop the ‘'OSTMOCMP’ to the Selected Registers pane. A green dot @ besides the 1/O register
indicates the status of being the selected register(s).

4. Switch to the Selected Registers tab to view ‘OSTMOCMP’ of the ‘OSTMO’ I/O register.

The expanded I/O register list may take a longer time to load in the All Registers pane. Hence, it is advisable
to customize and view multiple selected 1/O registers from the Selected Registers pane.
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5.4.9 Trace View

Tracing means the acquisition of bus information per cycle from the trace memory during user program
execution. The acquired trace information is displayed in the Trace view. It is helpful when tracking the program
execution flow to search for and examine points where problems have arisen.

The trace buffer is limited to a size of 1 to 32 Mbytes. The oldest trace data is overwritten with the new data
once the buffer has become full.

Tracing is not fully supported on the RZ/A1H.
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5.5 How to debug (RZ/A2M)

This chapter describes how to debug referring to the ‘Loader’ and ‘Application’ projects built in Chapter 3.2.1
and based on the hardware configuration: Segger J-Link emulator and RZ/A2M Evaluation Board Kit as target
board.

1. Click the ‘Loader’ project in the Project Explorer pane to set focus.

2. Build the ‘Loader Project’ (refer to Chapter 4.2), to create the ‘Loader.elf file.

3. Select ‘Loader HardwareDebug’ in the Launch Configuration of the Launch Bar.

& || %= || B | | Debug [£7 Loader HardwareDebug

Figure 5-28. Select Launch Configuration

4. Clickthe | # | button of Launch Bar, and connect to target board and download ‘Loader.elf’ file to it.

Connecting to R75921853VCBG, ARM Target
GDEServer endian : little
Target power : off

Starting target connection

Finished target connection

GDE: 57853

Target connection status - OK

Target connection status - OK

Starting download

Finished download

Figure 5-29. Console View After Download
5. Clickthe [ button on the Launch Bar to stop the debug session.
6. Click the ‘Application’ project in Project Explorer pane to set focus.
7. Build the ‘Application Project’ (refer to Chapter 4.2), to create the ‘Application.elf file.

8. Select ‘Loader HardwareDebug’ in the Launch Configuration of the Launch Bar.

& || % || ® | | % Debug |E| Application HardwareDebug I

Figure 5-30. Select Launch Configuration

9. Clickthe |# | button on the Launch Bar, to connect to the target board and download the
‘Application.elf file to it.

10. After downloading the ‘Application.elf file, click the {é::;: button to restart the program from the entry
point of ‘Loader.elf.
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6. Help

The help system allows you to browse, search, bookmark and print help documentation from a separate Help

window or help view within the workbench. You can also access an online forum dedicated to e? studio from
here.

Click on the Help tab to pull down the help menu.

Help

@ Welcome 1)
® Help Contents @)
% Search

Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
Cheat Sheets...
RenesasRulz Community Forum A3

Add Renesas Toolchains
Perform Setup Tasks...
Check for Updates

Install New Software...
Renesas e2 studio feedback

i& 1AR Embedded Workbench plugin manager...
@ About e studio

& BN

® &

Figure 6-1. Help Menu

Quick Help Tips

(1) Click Welcome for an overview of e? studio, a link to access the IDE tutorial and sample, and to view the
release notes.

(2) Click Help Contents to open a separate Help window with search function.

(3) Click RenesasRulz Community Forum to go online forum that is dedicated to topics and discussion
related to e? studio IDE. Internet connection is required.
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